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Client Suite
CSM provides multiple clients to access the system.
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CSM Desktop Client
The CSM Desktop Client is the Windows-based user application for CSM.
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CSM Desktop Client
The Desktop Client runs under Microsoft® Windows®, and provides all the features and default Business
Objects/processes for users who need to respond to and act on requests.

Desktop Client features include:

• Record Logging: Log and manage records (example: Incident, Problem, Change, Customer,
CMDB, etc.).

• Dashboards and Widgets: Use dashboards to view critical metrics, analyze and predict trends,
drill-down into data, execute Actions, or display information that might be relevant to a group of
users or customers.

• One-Step Actions: Run One-Step Actions to initiate one or more defined Actions, automating
common or repetitive tasks.

• Searching: Run Quick Searches or Saved Searches to efficiently and thoroughly search/filter your
CSM data, locating one record or a set of records.

• Customer: Use the Contact Manager to view and manage Customer records.

• Reporting: Use a host of powerful reporting tools (defined Reports and report writing tools, Search
Groups, Dashboards/Widgets, and Visualizations) to gather and measure data, analyze metrics, and
predict trends.

• Knowledge: Search for Knowledge from configured Knowledge Sources (example: Knowledge
Articles, records, attachments, web, etc.).

• Additional Features: Approvals, Attachments, Calendars, E-mail, Journals, Tasks, Queues,
Settings, Visualization, etc.

Related concepts
Tour the CSM Desktop Client
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Personalize the Desktop Client User Interface
Related tasks
Log in to the CSM Desktop Client or CSM Administrator
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Log in to the CSM Desktop Client or CSM
Administrator

Log in to the CSM Desktop Client or CSM Administrator from the machine on which these Windows-
based clients are installed.

To log in to the Windows-based clients:

1. Double-click the Cherwell Service Management icon  or CSM Administrator icon  on the
desktop, or select Start>All Programs>Cherwell Service Management or Cherwell
Administrator.

Note: If the Automatically Use Connection Without Asking check box was previously
selected or if the system administrator already set up a permanent database connection, the
database connection window will not open.

2. Select the All Users tab to view database connections available to all users or the User tab to view
database connections available to only to the user logging in.

3. Select a database connection. Typically, you connect using an Application Server (3-tier

connection), identified by the Application Server icon .
4. Select the Automatically Use Connection Without Asking check box to automatically use this

database connection each time CSM is launched.
5. Provide your CSM login information:

◦ User ID: Provide your CSM login ID. This could be domain name/network user name or just a
username).

◦ Password: Provide your CSM password. Passwords are case-sensitive.
6. Select OK.

If you are assigned to more than one CSM role and have not previously selected the Automatically
Use Selected Role check box, the Choose Role window opens.

7. Select the appropriate login role for the session.
8. Select the Always Use Selected Role check box to automatically use the selected role at the next

log in.

Related concepts
Connections
About Roles
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Tour the CSM Desktop Client
The CSM Desktop Client is personal, dynamic, and highly configurable. Each user has a personal
interface that is controlled by login role, security rights, and personal settings.

For example:

• Your default dashboard (displayed in the Main Pane when you log in or select the Home button)
might display real-time Incidents, Twitter Feeds, or metrics for your team.

• Your default calendar (displayed when you select the Calendar button) might display your active
Tasks.

• Your Task Pane might display your queues or your common operations, such as reports or One-
Step™ Actions.

The toolbars and panes are dynamic, so they change to accommodate active content. Toolbars and
panes are also configurable, collapsible, and dockable so that you can display what you want and put it
where you need it.

CSM provides a default Desktop Client interface; however, a system administrator typically tailors this to
meet your organization's requirements. For example, a system administrator can configure what to
display in the Task Pane, Knowledge Pane, Search Control, etc. With security rights, you can also
personalize the interface to meet your needs.

The following figure shows two sample main windows:

1. A sample dashboard in the Main Pane.

2. A sample Incident record, along with its arrangement, in the Main Pane. Notice that the Task Pane
and Knowledge Pane can be collapsed to allow more area. Also, notice that the Task Pane and
CSM Desktop Client toolbar change to display information and buttons specific to the active record.
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Related concepts
Personalize the Desktop Client User Interface
CSM Desktop Client
Related tasks
Log in to the CSM Desktop Client or CSM Administrator
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CSM Desktop Client Main Window
The CSM Desktop Client Main window is configurable and puts information at your fingertips. You decide
what to display and where to put it.

By default, the main window contains the following:

1. Menu bar: Dynamic row of drop-down menus that are used for common operations.

2. Toolbars: Dynamic row of buttons that are used for common operations.

3. Search Control: Search box to find specific words or phrases.

4. Culture Selector: Switch cultures to change the language for platform and content strings.

5. Task Pane: Highly configurable and dynamic tool used to quickly access operations.

6. Main Pane: Primary interface that displays the records, forms, and dashboards that you are working
on.

7. Knowledge Pane: Highly configurable and dynamic tool used to quickly access Knowledge Sources
in your Knowledge Base.

Related concepts
Tour the CSM Desktop Client
Personalize the Desktop Client User Interface
CSM Desktop Client
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CSM Desktop Client Menu Bar
Use the CSM Desktop Client menu bar to access common CSM operations.

The CSM Desktop Client menu bar is located at the top of the main window.

The Actions menu option is displayed only if it is configured in CSM Administrator.

File Menu

Action Description

New Creates a new record (example: Incident).

Save Saves the active record.

Abandon Abandons changes to the active record.

Delete Deletes the active record.

Print Prints the active pane.

Print Grid Prints the active grid.

Export Grid

Exports the active grid to the following formats:

• .csv

• .html

• .txt

• .rtf

• .xml

Send E-mail Creates an email to send.

E-mail Current Customer Creates an email to send to the active customer.

New Window Launches a new CSM window.

Logout Logs you out of the CSM Desktop Client.

Close Closes the CSM Desktop Client.

Edit Menu

Action Description

Undo Cancels the last operation.

Redo Repeats the last operation.

Cut Moves the selected item to the clipboard, where you can paste the item into a new
location.
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Action Description

Copy Copies the selected item to the clipboard, where you can paste the item to a new
location.

Paste Inserts an item from the clipboard.

Show Legal
Values Displays a list of legal values (for Lookup fields only).

Refresh Refreshes the active record.

Zoom Zoom the field into a larger window.

Unlock Releases the lock (unlocks) the active record.

User Locks Opens the Record Locking Manager, where you can view and release any/all
locked records.

View Menu

Action Description

Task Pane
Displays/hides the Task pane.

For more information, see CSM Desktop Client Task Pane.

Knowledge
Displays/hides the Knowledge pane.

For more information, see CSM Desktop Client Knowledge Pane.

Navigation (window) Displays the default dashboard and navigates back/forward through the session
history.

Record (Navigation) Navigates through the current record set.

Searching Menu

Action Description

Search Manager Opens the Search Manager, where you can run and manage saved searches.

Quick Search Builder Opens the Quick Search window, where you can build a quick search.

Edit Current Search Opens the Edit Search window, where you can change the parameters of the
active search.

Save Current Search
As Saves the active search as a saved search that you can use again later.

MRU list
Lists the MRU (Most Recently Used) items.

For more information, see Configure User General Settings.
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Action Description

Install PowerBI Data
Connector

Installs the Power BI Data Connector to use with third-party reporting tools.

For more information, see Using Search Data with Third-Party Reporting
Tools.

Note: If a Business Object has been previously applied to your system as part of a Protected
mApp™ Solution:

• You see a shield icon  next to each content-protected search.

• You can't edit or delete a content-protected search.

• See Protected mApp Solutions.

One-Step™ Action Menu

Action Description

One-Step Action Manager Opens the One-Step Manager, where you can run and manage One-Step
Actions.

One-Step Action Blocks Opens the Action Block Manager.

MRU list Lists the most recently used (MRU) One-Step Actions.

Customer Menu

Action Description

Contact Manager Opens the Contact Manager, where you can view and manage customer records.

Current Info Displays the current customer's information.

Config Items
Displays the current customer's configuration Items.

For more information, see About the Configuration Management Database (CMDB).

Dashboards Menu

Action Description

Dashboard Manager Opens the Dashboard Manager, where you can view and manage
dashboards.

Edit <current Dashboard>
Opens the Dashboard Editor, where you can edit the current dashboard.

For more information, see Dashboard Editor.
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Action Description

Set <current Dashboard>
as default Changes the current dashboard to be the user default.

Focus on Dashboard Sets focus on the current dashboard view.

Widget Manager Opens the Widget Manager, where you can manage widgets.

Metric Manager Opens the Metric Manager, where you can manage metrics.

Color Palette Manager Opens the Color Palette Manager, where you can manage color palettes.

Heads-up Display
Opens the Heads-Up Display (HUD) in a new window.

For more information, see Heads-Up Display (HUD).

MRU list Lists the most recently used (MRU) Dashboards.

Tools Menu

Action Description

CMDB
Opens the CMDB Interface, where you can manage Configuration Items (CIs).

For more information, see CMDB Interface.

Queues Opens the Queue Manager, where you can manage queues.

Knowledge

Opens the Knowledge Pane, where you can search configured knowledge
sources.

For more information, see CSM Desktop Client Knowledge Pane.

Reports Opens the Report Manager, where you can run and manage reports.

Calendars Displays the default (Main) calendar. Also displays an option to open the
Calendar Manager, where you can view and manage calendars.

Visualizations Displays the default Visualization. Also displays an option to open the
Visualization Manager, where you can view and manage visualizations.

Attachments Opens the Attachment Manager, where you can view and manage attachments.

Current Record
Automation
Processes

Displays Automation Processes for the current record.

For more information, see View Automation Processes for a Single Record.

Table Management

Opens the Table Management interface, where you can manage Lookup Table
values.

For more information, see Table Management Interface.

Options

Opens the Options window, where you can configure personal settings (example:
general, display, task pane/search control, dashboard/HUD/calendar, user
information, and email).

For more information, see Configure User Settings.
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Action Description

Network Health
Check

Runs the Network Health Check, which tests to validate network speed and
connectivity.

For more information, see Network Health Check.

Actions Menu
If configured, an additional Actions menu is available when a record is displayed in the Main Pane
(example: The Incident Actions menu item displays when an Incident is active). The actions are defined
as part of the Business Object definition in CSM Administrator.

Action Description

Quick Templates Displays a list of available quick templates (example: Reset Password).

Localization Menu

Action Description

Culture Quick Swap (CTRL+W) Switch between the preferred culture and the last
selected culture.

Preferred Culture (CTRL+D) Switch to the preferred culture.

Previous Culture (CTRL+L) Switch to the last culture you selected.

Help Menu

Action Description

Contents Opens the online help.

Reload Definitions Reloads all definitions.

Current Field
Information

Displays properties for the active field (example: Name, type, description,
search properties, required or not, validation, and field ID).

Report Error Opens the Report Error window so you can report an error to Cherwell.

System Analyzer Opens the System Analyzer, where you can track behind-the-scenes
operations in a live environment directly from the CSM Desktop Client.

About Displays information about CSM (version, copyright, licensing details, and
contact information).

Related concepts
Tour the CSM Desktop Client
CSM Desktop Client
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CSM Desktop Client Quick Search Widget
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CSM Desktop Client Quick Search Widget
Use the CSM Desktop Client Quick Search Widget to search records for all Business Objects or records
for a specific Business Object. The CSM Desktop Client Quick Search Widget is located in the top-right
corner of the window.

Table 1. CSM Desktop Client Quick Search Widget Options

Action Description

Choose Items to
Search (drop-down
list)

Drops down so that you can select Quick Search or a specific Business Object
to search:

• Quick Search: Searches all records that contain a specific word or phrase.

• Specific Business Object Search: Only searches records for the selected
Business Object (Example: Incident).

See Quick Search and Quick Search Good to Know for more information.

See Configuring Search Defaults for specific information on enabling/disabling
Business Objects for search.

Quick Search (text
field)

Type or select the search word or phrase. The most recently used searches
appear in a drop-down list.

Go (magnifying
glass icon)

Runs the search. Search results are displayed in a grid (if they are of the same
type) or a list (if they are of different types). By default, the search results display
according to their Relevancy ranking, which means the records most likely to be
relevant to your search string display at the top of the results. See Quick Search
Results for more information.

Search Options
(wrench icon)

When searching a specific Business Object, select the wrench icon to define
options to refine the search: Changed, Open records only, Relationships,
Attachments, Sort By, etc.

Changed Limits the search to records that have changed during a specific timeframe.
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Action Description

Open (records)
only

Limits the search to records that have not reached their final state (example: not
closed). If the Business Object does not have a "final" or closed state, this option
does not appear.

Note: The lifecycle and terminology vary depending on the Business Object and
scenario (examples: Unapproved Changes only might appear when searching
Changes, Non-Retired only might appear when searching Knowledge Articles).

Relationships
Includes related Business Objects in the search (example: If the search word
appears in a Journal entry, the Incident to which it is attached will be included in
the search results).

Attachments When selected, the search returns results that match the text within .txt, .doc,
and .xls files and will return any file type with a matching file name.

Sort by

Selects the Business Object field (column) to use to sort the search results. By
default, the search results display according to their Relevancy ranking, which
means the records most likely to be relevant to your search string display at the
top of the results.

See Quick Search Results for additional information.

Descending Sort
Order Sorts the results in descending order instead of ascending order.

Search Manager Opens the Search Manager where you can create a Saved Search.

Close Closes the Search options drop-down box.

Related concepts
About Quick Search
Quick Search Results
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CSM Desktop Client Toolbar
Use the CSM Desktop Client toolbar to quickly access common CSM operations. By default, all toolbars
are located under the menu bar in the main window; however, you can independently display/hide and
move/dock each toolbar so that you can display them when and where you want.

Buttons are dynamic. For example, the Lock button appears only when a record is displayed in the Main
window; the Save button is disabled until CSM detects that there is content to save.

The toolbar is made up of several smaller toolbars:

• Main toolbar: Displays buttons for performing common CSM operations.

• Navigation toolbar: Displays buttons for navigating between records (example: Incident, Problem,
etc.).

• Action toolbars: Display buttons specific to the type of record displayed in the Main Pane
(example: The Incident toolbar displays when an Incident is active). These toolbars are created as
part of the Business Object definition in CSM Administrator.

• User toolbars: Display personal toolbars that users create.

• Arrangement/Relationship toolbars: Display buttons for working with form arrangement records
(child records in a relationship with a parent record).

Main Toolbar

Button Action Description

Back/Forward Navigates backward or forward in
the content pane sequence.

Home Displays the CSM Home page with
the default dashboard active.

Calendar Displays the default calendar.

New
Displays item options (you choose
the type). The icon on the button
indicates the type of record.

Save Saves changes in the active
window.

Abandon Abandons changes to the current
item.
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Button Action Description

Lock Record

Unlock Record

Record is locked by another
User

Locks the active record.

Unlocks the active record.

Record is locked by another user.

Note: This button toggles
depending on the current
status of the active record
and who has the record
locked. This button
appears only if record
locking is enabled and
only when a record is
active in the CSM Main
Window.

Cut
Moves the selected item to the
clipboard, so you can then paste
the item into a new location.

Copy

Creates a new item whose
properties are the same as the
copied item. The new item can
then be named and customized.

Paste Inserts an item from the clipboard
to a new location.

Attach

Attaches a file, Web page, image
or shortcut. Also, has an option for
displaying/hiding the Attachment
Bar.

Show Legal Values (Lookup) Displays a list of legal values (for
lookup fields only).

Print Prints the active pane.

Search Manager
Opens the Search Manager,
where you can run and manage
Saved Searches.

Navigation Toolbar

Button Action Description

Show results Displays a set of records meeting
a specific criteria.
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Show current record Displays the currently selected
record.

Go to first record Jumps to the first record in set.

Go to previous record Jumps to the previous record in
set.

Go to next record Jumps to the next record in set.

Go to last record Jumps to the last record in the set.

Action Toolbar
The Action toolbars are created as part of a Business Object definition, vary by Record Type (example:
Incident is different than Problem), and appear only when a record is open.

Form Arrangement/Relationship Toolbar
The Relationship toolbars are created as part of the form arrangement definition, vary by relationship, and
appear only when a child tab is displayed in an arrangement. The following figure shows an example of a
Configuration Item (CI) toolbar displayed in an Incident's arrangement.

Button Action Description

Link Adds/links additional items.

Unlink Unlinks the selected item.

Go To (Quick View) Goes to the source record.

Save Saves changes in the active window.

Quick View Opens the item in a second window so you can take a quick look
at the details.

Go to first record Jumps to the first record in the set.

Go to previous record Jumps to the previous record in the set.

Go to next record Jumps to the next record in the set.

Go to last record Jumps to the last record in the set.
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Filter Filter items in the Grid.

Print Prints the active Grid.

Export Export Grid to a file.

View

Displays items as:

• Form

• Grid

• Split screen (both Form and Grid): horizontal or vertical.

Related concepts
Tour the CSM Desktop Client
CSM Desktop Client
Protected mApp™ Solutions
Protected mApp™ Solution FAQs
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CSM Desktop Client Task Pane
The CSM Desktop Client Task Pane is highly configurable and is used to quickly access tasks. The tasks
in the Task Pane vary depending on the active item in the Main Pane (example: If an Incident is active,
the tasks will be Incident-specific).

By default, the Task Pane is located on the left side of the main window; however, you can display it/hide
it, collapse/pin it, and move/dock it so that you can display it when and where you want.

A system administrator initially chooses which items appear by default for each role; however, if you have
security rights, you can select which items appear on your own Task Pane.

Table 1. CSM Desktop Client Task Pane Options

• Quick Search: Displays the Quick Search options.

• Common Tasks: Displays tasks you frequently do.

• Actions: Displays common actions for the active record. This area changes based on the
record (Business Object) you are working with.

• Queues: Displays the current record and a list of specific grouped records.

Note: For more information, refer to About Queues.

• Process & Terminology: Displays helpful text for the active record.

• Customer Info: Displays a mini customer summary for any active record that allows you to
select a customer (example: Incident).

 

Related concepts
Tour the CSM Desktop Client
Quick Search in the Task Pane
Personalize the Desktop Client User Interface

CSM 2022.3 Client Suite 27

CSM 2022.3 Client Suite

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=about_queues
https://help.cherwell.com/bundle/csm_client_suite_2022_3_help_only/page/content%2Fclient_suite%2F..%2F..%2Fcontent%2Fclient_suite%2Ftour_the_csm_desktop_client_user_interface.html
https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=quick_search_pane
https://help.cherwell.com/bundle/csm_client_suite_2022_3_help_only/page/content%2Fclient_suite%2F..%2F..%2Fcontent%2Fclient_suite%2Fpersonalize_the_desktop_client_user_interface.html


CSM Desktop Client Main Pane
Use the CSM Desktop Client Main Pane to view data and to perform the majority of your CSM operations.
Upon logging in, the Main Pane displays the Home Dashboard.

Depending on the operation, the Main Pane can also display:

• Records: Incidents, Problems, Knowledge Articles.

• Search Results: Quick Search, Knowledge Search, etc.

• Default Calendar.

• Contact Manager.

• Configuration Management Database (CMDB).

• Table Management.

Related concepts
Tour the CSM Desktop Client
Personalize the Desktop Client User Interface
CSM Desktop Client
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CSM Desktop Client Knowledge Pane
Use the CSM Desktop Client Knowledge Pane to quickly access the Knowledge Sources in your
Knowledge Base (example: Knowledge Articles, Business Objects, web, etc.). The available Knowledge
Sources vary depending on which Business Object is displayed in the CSM Main Pane.

By default, the Knowledge Pane is located on the right side of the main window; however, you can
display/hide it, collapse/pin it, and move/dock it so that you can display it when and where you want.

When you run a Knowledge Search, the results appear at the bottom of the pane. Results display in order
of Relevancy ranking. This means the records most likely to be relevant to your search string display at
the top of the results by default.

See CSM Desktop Client Knowledge Pane for more information.

CSM 2022.3 Client Suite 29

CSM 2022.3 Client Suite

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=knowledge_pane


Related concepts
Tour the CSM Desktop Client
Personalize the Desktop Client User Interface
CSM Desktop Client
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Personalize the Desktop Client User Interface
The CSM Desktop Client interface is highly configurable. If you have been granted security rights, you can
configure settings made by your system administrator, as well as display, hide, move, and dock certain
elements.

You can:

• Configure dser settings: General, display, task pane/search control, dashboard/HUD/calendar, user
information, and email. See Configure User Settings.

• Display/hide a toolbar or pane.

• Pin/collapse a pane.

• Move/dock a pane.

• Move/dock a toolbar.

• Create a personal user toolbar. See Create a User Toolbar.
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Configure User Settings
Global and user settings are initially configured in CSM Administrator. Personal settings/defaults can be
configured in CSM Desktop Client and control how CSM looks and behaves for each user. Use the CSM
Options window (Tools > Options) to configure user settings.

• User General settings: Restore, searching, MRU (Most Recently Used), IME (Input Method Editor),
catalog, and logging settings.

• User Display settings: Application skin, window titles, and accessability options.

• User Task Pane and Search settings: Which default items appear in the Task pane and which
search control is used on the CSM menu bar.

• User Dashboard and Calendar settings: Personal default dashboard and dashboard theme,
Heads-Up Display (HUD), calendar, and mobile dashboard. You can also configure personal web
proxies for web requests.

• User Information settings: Personal login credentials, authentication, user profile information.

• User Email settings: Personal email accounts.

• Manage Delegates: Delegates to take over your work when you are unavailable. See Delegate
Work.
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Configure User General Settings
Use the General page in the Options window User options, such as restoring Grids and Prompts to their
default settings, defining the number of MRU (Most Recently Used) Items, and setting logging options.

To configure User General settings:

1. From CSM Desktop Client the menu bar, select Tools>Options.

2. Select the General page.

3. Select the following options as they apply.

Option Description

Restore All Dismissed Message Prompts
Select this check box to restore any previously
dismissed message prompts so that they appear
again.

Restore All Customized Grids to Admin Defaults Select this check box to restore all customized Grids
back to their default definitions.

If Only One Record is Found in a Search,
Automatically Go To That Record

Select this check box to be directed straight to the
only search result, instead of first viewing the single
item in a Grid List.

MRU (Most Recently Used) Items

Use the up and down arrows to increase or
decrease the number of CSM Items that display in
the item's MRU list (in the CSM Desktop Client
menu bar). Ten items display by default.

Use IME Compatible Multi-line Text Controls

Select this check box to allow Input Method Editor
(IME) capabilities so that Users can enter
characters and symbols (example: Chinese,
Japanese, or Korean language symbols) not found
on the input device (example: Keyboard).

Definition Catalog

Select an option for storing primary system
definitions in a local catalog file.

◦ Use System Setting: Select this option to
adhere to the Administrator definitions of
catalog usage.

◦ Use a Local Definition Catalog: Select this
option to ensure the usage of a catalog,
regardless of Administrator definitions.

◦ Don't Use a Local Definition Catalog: Select
this option to ensure a catalog is not used,
regardless of Administrator definitions.

This option is only available if your administrator has
enabled it.

Configure Logging Select the Configure button to open the Logging
options window. See Logging Options.
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4. Select OK.

Related concepts
Configure Global Catalog Settings
Logging Options
Configure Logging to a Splunk Server
Related tasks
Reset to the System Grid Definition
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Configure User Display Settings
You can configure display settings specific to the logged-in user. These user display settings override
some global display settings.

To configure user display settings in the CSM Desktop Client select Tools > Options > Display.

Application Skin
To control the appearance of the Desktop Client and CSM Administrator, select an application Skin.
Options are Cherwell Light (default), Cherwell Blue, or Cherwell Dark.

Window Titles
To configure window title settings, select the Display connection information check box, then select an
option from the drop-down list. The available window title types are:

• Connection name: Displays as <connection name> connection.

• Database name: Displays as <database name> database.

• Environment name: Displays as <environment name> environment (Production, Development, or
Test).

• Connection and database name: Displays as <connection name> connection, <database name>
database.

• Connection and environment name: Displays as <connection name>, <environment> name.

• Database and environment name: Displays as <database name> database, <connection name>
connection name.

• Connection, database, and environment: Displays as <connection name> connection, <database•
name> database, <environment name> environment.

If no environment value is selected, the content displays as Unknown environment.

Note: To see the setting changes, you must log out and log in again or switch culture.
This setting applies to all CSM databases (example: CSM Administrator) on your current
computer.

This setting overrides the global setting for window title settings.

Accessibility
By default, forms display with high-contrast colors.

To assists users with accessibility needs, select the Override Business Object form themes with
Windows colors (for high-contrast users) check box.

Windows colors are used instead of the form's defined theme.

Related concepts
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Configure Global Display Settings
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Configure User Task Pane and Search Control
Settings

Use the Task Pane and Search page in the CSM Options window to configure which default items appear
in the Task Pane and which Search Control is used on the menu bar.

To configure User Task Pane and Search Control settings:

1. From the menu bar, select Tools>Options.

2. Click the Task Pane and Search page.

3. Configure Task Pane settings:
◦ View or hide sections.

◦ Add new sections.

◦ Configure sections (only applicable to new sections).

◦ Delete sections (only applicable to new sections).

◦ Organize sections.

4. Check or uncheck the corresponding check box to view or hide the following sections in the Task
Pane:

◦ Quick Search

◦ Common Tasks

◦ Actions

◦ Queues

◦ Process and Terminology

◦ Customer Information

5. Add items to the Task Pane (if not using the Default Task Pane Setup):
a. Uncheck Default Task Pane Setup check box.

b. Click Add to open the Task Pane Section window.

c. Specify a name for the Task pane section.

d. Click Add to open the Action Manager.

e. Select the items you want to appear in the Task Pane (example: Calendars).

6. Customize the CSM Search Control in the menu bar Search Options:
◦ Use Default: Use the Default Search Menu Search Widget, which allows Users to run a Quick

Search on multiple Business Objects simultaneously (example: Knowledge Article and Change
Request). Users can also select a Business Object in the drop-down to search one item at a
time (Specific Search).

◦ Use Search Widget: Click the Ellipses button to open the Widget Manager and select an
existing Search Widget or create your own.

◦ No Menu Bar Search: Remove the option to search from the menu bar.

7. Select OK.7.
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Configure User Dashboard and Calendar Settings
Use the Dashboards & Calendars page in the CSM Desktop Client to configure a default home
dashboard, heads-up display HUD), and calendar. You can also clear the local metric cache.

To configure user dashboard and calendar settings:

1. From the CSM Desktop Client menu bar, select Tools>Options.
2. Select the Dashboards & Calendars page.
3. Select a default dashboard:

◦ Select the Use default option to use the global default Dashboard.
◦ Select the Dashboard option, and then select the icon to open the Dashboard Manager so

you can select a different dashboard.
4. Select a default heads-up display:

◦ Select the Use default option to use the global default HUD.
◦ Select the Heads-up Display option, and then select the icon to open the Dashboard

Manager so you can select a different HUD.
5. Select a default calendar:

◦ Select the Use default option to use the global default calendar.
◦ Select the Calendar option, and then select the icon to open the Calendar Manager so you

can select a different calendar.
6. Select the Customize Mobile Settings check box to override the default mobile dashboards

configured in CSM Administrator.

Note: The CherwellMobile applications for iOS and Android were deprecated in March 2019
and are no longer available in their respective application stores. CherwellMobile
applications that are already installed should continue to work as expected, however.

7. Select the Allow Web Proxy for RSS, Twitter, and Other Web Requests check box to allow Web
Proxy for RSS, Twitter, and other Web requests.

8. Select Clear the Local Metric Cache to clear the metric values stored on your local machine.
9. Select OK.
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Define Personal User Information
Use the User Information page in the CSM Options window to configure User Login Credentials,
Authentication options, and User details.

To configure User Information settings:

1. From the menu bar, select Tools>Options.

2. Click the User Info page.

3. View or change the information for the current User.

4. Select OK.4.

CSM 2022.3 Client Suite 40

CSM 2022.3 Client Suite



Configure User Email Settings
Use the E-mail page in the CSM Options window to configure the following user email settings:

• Add a new email account.

• Edit or copy an existing account.

• Delete an account.

• Designate an account as the default account for sending emails from within CSM.

• Find dependencies.

To configure user email settings:

1. From the menu bar, select Tools > Options.

2. Select the E-mail page.

3. Configure a personal email account or customize a global email account:
◦ Add: Configure a new personal email account (POP, IMAP, or Exchange).

◦ Edit: Edit the settings for an existing account.

◦ Delete: Delete an existing account.

◦ Revert: Remove your personal settings and revert to the default settings for a global email
account.

◦ Copy: Copy the settings for an existing account, and then edit the settings as necessary.

4. Define email account settings:
a. Define personal POP or IMAP Account settings.

b. Define personal Microsoft Exchange Account settings.

5. Spell check email: Select this check box to have CSM spell-check emails before they are sent.

6. Make default account: Makes the selected account the default account for sending emails within
CSM.

7. Find dependencies: Displays other CSM Items using the selected email account (example: An E-
mail and Event Monitor).

8. Select OK.8.

Note: For more information about email accounts and how to use email in CSM, refer to the
E-mail documentation.
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Configure Delegates
Using the CSM Desktop Client or CSM Browser Client, hand off some or all of your work to a colleague
(delegate) when you are unavailable. For example, you can use a delegate when you are going on
vacation or long-term sick leave.

Use the Manage Delegates page in the CSM Options window to configure the following delegate
settings:

• Business Object.

• Choice of delegate(s).

• Start Date and Time.

• End Date and Time.

To configure delegates, see Delegate Work.

Related concepts
About Delegation
About Approvals
Related tasks
Delegate Work
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Configure User Cherwell Mobile Settings
Use the Default Mobile Access window (accessed from the Dashboards & Calendars page in the CSM
Desktop Client Options window) to configure how Cherwell Mobile looks and behaves on your personal
mobile device. You can configure which:

• Mobile Home Dashboard to display by default.

• Mobile Alert Dashboard to display by default.

• Business Objects to make available. Associated Saved Searches will also be available.

• Actions/One-Step Actions to make available for each Business Object.

Good to know:

• The Cherwell Mobile applications for iOS and Android were deprecated in March 2019 and are no
longer available in their respective application stores. Cherwell Mobile applications that are already
installed should continue to work as expected, however.

• Users must have Cherwell Mobile security rights to configure User Cherwell Mobile settings.

To configure User Cherwell Mobile settings:

1. From the CSM Desktop Client toolbar, click Tools>Options.

2. Click the Dashboards and Calendars page.
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3. Select the Customize Mobile Settings check box.

Note: If you do not have rights, this check box does not show up in the window. If you clear
this check box, the Cherwell Mobile settings revert to the Global or Role default.

CSM 2022.3 Client Suite 44

CSM 2022.3 Client Suite



4. Select default Mobile Dashboards (Home and Alert)

Tip: If you do not want to display any Dashboards, remove the Dashboard item from the List of
Objects to Display on Mobile Device list.

a. Home Page: Select a default Mobile Home Dashboard.
◦ Click the drop-down to select from a list of recently used Mobile Dashboards.

◦ Click the Mobile Dashboard button  to open the Mobile Dashboard Manager, and
then select an existing Mobile Dashboard or create a new Mobile Dashboard.

b. Alerts Page: Select a default Mobile Alert Dashboard.
◦ Click the drop-down to select from a list of recently used Mobile Dashboards

◦ Click the Mobile Dashboard button  to open the Mobile Dashboard Manager,and
then select an existing Mobile Alert Dashboard or create a new Mobile Alert Dashboard..

5. Select the Business Objects to make available in Cherwell Mobile:

Note: In order for a Business Object to be available, it must have the Show in Search
Manager property set (in the Business Object properties within a Blueprint).

a. Override List of Objects to Display on Mobile Device: Select this check box to override the
current default list of available Business Objects (Global or Role, set in CSM Administrator).

b. Click Add, and then select the Business Object to make available on mobile devices.
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Tip: Click Edit to edit a selected item. Click Remove to remove the selected item from the list.

c. Define how to display the Business Object in Cherwell Mobile:
◦ Custom Name: Provide a display name to use in Cherwell Mobile. If this is left blank,

the Business Object name will be displayed.

◦ Custom Image:

Select the image to open the Image Manager, and then select an existing image or
import a new image to represent the item in the UI.

If you do not select an image (None), the default image for the Business Object is
displayed.

Android: Android devices use standard color images. For the best results, use the
images in the BusObs>32x32 folder in the Image Manager. If you are setting up a mobile
configuration for use on both Android™ and iOS® devices, use the iOS-specific images.
They are automatically mapped to equivalent standard images for non-iOS® devices.

d. Select the Actions/One-Step Actions to make available in Cherwell Mobile:
i. Click Add to add a new Action/One-Step Action to the list.
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Tip: Click Edit to edit a selected item. Click Remove to remove the selected item from

the list. Use the Up/Down arrows   to change the order of the Actions/One-Step
Actions when displayed in Cherwell Mobile (ex: In the Actions list).

ii. Define additional options for the list of Actions.
◦ Also Show Default Business Object Actions: Select this check box to make

available any default Actions for the Business Object. This option is only available if
the Business Object has default Actions available (ex: Approvals have built-in
functionality to approve, deny, and abstain).

◦ Also Show Role Actions: Select this check box to make available any Actions that
were configured for the Business Object as part of the User’s default Role settings.
If no defaults were configured for the Role, then Global defaults are used.

6. Configure the order of the Actions when displayed in Cherwell Mobile (ex: On the Actions popup
list):

a. Use the Up/Down arrows to order the Actions.

Note: You can change the order for all custom Actions/One-Step Actions, but you
cannot change the order of the Barcode scan, camera, and Location Awareness
Actions/One-Step Actions.

7. Select OK.7.
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Display/Hide a Toolbar or Pane
The CSM toolbars and Knowledge Pane can be displayed or hidden.

To display/hide a toolbar or pane:

1. Right-click anywhere on a CSM menu bar, toolbar, or pane.

A drop-down appears, listing the items that can be displayed/hidden. Currently displayed items have
a check next to them.

2. Select an item to display it. Clear a checked item to hide it.
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Pin/Collapse a Pane
The Task Pane and Knowledge pane can be temporarily viewed, or permanently pinned in the CSM Main
window.

To pin/collapse a pane:

• Click the Pin button  in the upper right corner of a pane to collapse it. The pane displays as a tab
on the left side of the CSM Main window.

• Click the tab to temporarily view a collapsed pane. The pane displays until the cursor is removed
from inside the pane.

• Click the horizontal Pin icon  to permanently display the pane.

CSM 2022.3 Client Suite 49

CSM 2022.3 Client Suite



Move/Dock a Pane
The Task Pane and Knowledge Pane can be moved anywhere within the CSM Main window or docked to
their default locations.

To move a pane:

1. Click the banner title until a Four-Arrow Plus Sign  appears.

2. Drag the pane to any location in the CSM Main window. After the pane is removed from the original
location, it becomes a small window that can be resized.

The following image shows the Task Pane moved into the Main Pane.

Tip: To dock the pane back to its default location, double-click the banner title.
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Move/Dock a Toolbar

Use the Grab bars  on a CSM toolbar to move, dock, and re-dock a toolbar.

To move a toolbar within the menu bar and toolbar area:

1. There are two ways to move a toolbar:

◦ Double-click the Grab bar  on the left side of the toolbar, and then drag the toolbar to a new
location within the toolbar area.

Note: If the toolbar is moved from the toolbar area, it becomes an independent window that
can be resized.

◦ Click the Grab bar until the Four-Arrow Plus Sign  appears, and then drag the toolbar to
a new location within the toolbar area.

The following figure shows the Navigation toolbar moved to the line below where it was initially
pinned.

2. Let go of the cursor to dock the toolbar.

To move a toolbar outside the menu bar and toolbar area:

1. There are two ways to move a toolbar:

◦ Double-click the Grab bar  on the left side of the toolbar, and then drag the toolbar to a new
location in the CSM window.

Note: If the toolbar is moved from the toolbar area, it becomes an independent window that
can be resized.

◦ Click the Grab bar until the Four-Arrow Plus Sign  appears, and then drag the toolbar to
a new location within the CSM window.

The following figure shows the Navigation toolbar moved to the Main pane.

Tip: Double-click the header banner of an undocked toolbar to re-dock the toolbar back to its
default location.
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Create a User Toolbar
Create one or more personal toolbars (called a User toolbar) to initiate important Actions. For example,
create a User toolbar to:

• Run a One-Step Action.

• Run a command (Zoom, Attach, Undo, etc.).

• Display a Dashboard, Calendar, or Visualization.

• Run a Report or Saved Search.

A User toolbar displays with the other CSM toolbars in the CSM Main window.

To create a User toolbar:

1. Right-click anywhere in the CSM toolbar area, and then select Customize.

The toolbars for User window opens.

2. Click the Add button.

The New Toolbar window opens, listing Actions that are applicable for a toolbar.

3. Click the Add Action button , and then select the type of Action to add to the toolbar (ex: Add
Command Action).

A CSM Item Manager opens (varies by type of Action selected in the previous step) to select/create
the CSM Item to initiate through the Action.

4. Select a CSM Item (ex: a specific Dashboard).

5. Define properties for a new Action:
a. Action: Displays the name of the Action as it is recognized by CSM (ex: Name of the

Dashboard or Report). It is recommended that you do not change this.

b. Display text: Type the text to display on the toolbar button if the "Show text on button check
box" (below) is checked.

c. Image button:

Select the image to open the Image Manager, and then select an existing image or import a
new image to represent the item in the UI.

d. Help text: Type a tooltip to display when the cursor is on the menu item.

e. Begin group: Select this check box to display a horizontal line before the menu item,
separating it from other menu items.

f. Show text on button: Select this check box to display the Display Text on the toolbar button.

6. Add additional actions to the toolbar.

7. Select OK.7.
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Keyboard Shortcuts
You can use the following keyboard shortcuts when working in the CSM Desktop Client.

Key Action

F1 Help

F2 Rename current item

F3 Show the legal values for a field

F4 Heads Up Display

F5 Refresh

F6 Displays the current user's information

F7 Displays the current user's configuration items

F8 Zooms the current field (if a large text field)

F10 Select Menu

Ctrl+C Copy current text to the clipboard

Ctrl+D Switch to the preferred culture.

Ctrl+K Paste the text from the current field into Knowledge Search pane

Ctrl+L Switch to the last culture you selected.

Ctrl+S Save the current record

Ctrl+T Toggle between form and list views

Ctrl+V Paste text from the clipboard

Ctrl+W Switch between the preferred culture and the last selected culture.

Ctrl+X Cut current text to the clipboard

Ctrl+Y Redo last operation that was undone

Ctrl+Z Undo last operation

Alt+Down arrow key
Open a combo-box

Move down in a list of records

Alt+Left arrow key Move back to previous location

Alt+Right arrow key Move forward
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Key Action

Alt+F1–F8 Select tab in the current form arrangement

Ctrl+F4 Go to home page

Ctrl+F5
Displays Self-Service settings (Self-Service setup must be configured on your
machine and you must be on a customer type that is set up to be exposed via
Self-Service)

Ctrl+scroll Zoom in/out in editors

Ctrl+Shift+E Email current customer

Ctrl+Shift+F Displays the grid filter for a selected grid column

Ctrl+Shift+K Paste the text from the current field into Knowledge Search pane and searches

Shift+drag Ignore snapping in an editor

Defined in our database, but can be changed by the user:

Ctrl+Shift+I New Incident

Shift+Alt+C Go to Quick Search for customer
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CSM Web Applications
CSM includes two web applications: the Browser Client and the CSM Portal.
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CSM Browser Client
The Browser Client is a web-based alternative to the CSM Desktop Client. The CSM Browser Client is
supported on most major modern browsers on desktop machines and mobile devices.

The configurations and settings for the Browser Client are determined in the CSM Desktop Client and
CSM Administrator. Many functions behave differently in the Browser Client than they do in the Desktop
Client. To see the differences in functionality between the Browser Client and the Desktop Client, see
CSM Client Feature Parities and Differences
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Tour the CSM Browser Client
The Browser Client provides access to CSM through a web browser. Each user has a personal interface
that is controlled by login Role and security rights. For example, the default dashboard (displayed in the
main pane upon log in or by clicking the Home button) might display real-time Incidents, Twitter feeds, or
metrics for a team.

Browser Client features include:

• Record Logging: Log and manage records (Incident, Problem, Change, Customer, etc.).

• Searching: Run Quick Searches or saved searches to efficiently and thoroughly search and filter
CSM data. You can locate one record or a set of records.

• One-Step Actions: Run One-Step Actions to initiate one or more defined Actions, automating
common or repetitive tasks.

• Email: Define and send messages to a single recipient or a group of recipients using
comprehensive email functionality.

• Dashboards and Widgets: Use dashboards to view critical metrics, analyze and predict trends, drill
down into data, execute Actions, or display a collection of information that might be relevant to a
group of users.

• Reporting: Use a host of powerful reporting tools (defined Reports and report writing tools, saved
searches, dashboards/widgets, and visualizations) to gather and measure data, analyze metrics,
and predict trends.

• Visualizations: View visualizations to see the relationships between records in a variety of layouts.

• Calendars: View calendars to keep track of ongoing or upcoming tasks.

• Tools: Access the Contact Manager, Table Management, and CMDB.

• Additional Features: Access HTML pages, Knowledge Articles, and queues.

Related concepts
CSM Browser Client
Use the Browser Client
Log in to the Browser Client
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Browser Client Main Window
The Browser Client main window is simplified compared to the CSM Desktop Client, but most of the same
features are available.

1. Account Information: Displays login and user/company information.

2. Menu bar: Displays drop-down menus for features and functions within the Browser Client. The
menu bar collapses into a hamburger menu on mobile screens and browser windows sized below
768 pixels.

3. Search Control: Allows Users to run quick searches and specific record searches.

4. Toolbar: Displays available actions and operations within the main pane and within records.

5. Main pane: Displays dashboards, records, reports, and search results.

Item Managers are opened from the menu bar. To open a Manager, select a menu (example:
Dashboards), and then select [Item] Manager.
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Browser Client Main Pane
The Browser Client main pane is located in the center of the main window and displays content relevant
to the current operation. When you log in, the main pane displays the Home Dashboard.

Depending on the operation, the main pane can also display the following:

• Records (Incident, Problem, Knowledge Article, etc.).

• Search results (quick search, Knowledge Article Search, etc.).

• Reports, calendars, visualizations, grids, and more.
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Browser Client Quick Search Widget
Use the Browser Client Quick Search Widget to search records for all Business Objects or records for a
specific Business Object.

The Browser Client Quick Search Widget is located in the top-right corner of the window.

Table 1. Browser Client Quick Search Widget Options

Item Description

Quick Search (drop-down list)

Select Quick Search or a specific Business Object to search:

• Quick Search: Searches all records that contain a specific word or
phrase.

• Specific Business Object Search: Only searches records for the
selected Business Object (example: Incident).

See Quick Search and Quick Search Good to Know for more information.

See Configuring Search Defaults for specific information on enabling/
disabling Business Objects for search.

Quick Search (text field) Type or select the search word or phrase. The most recently used
searches appear in a drop-down list.

Go (magnifying glass icon)

Run the search. Search results are displayed in a grid (if they are of the
same type) or a list (if they are of different types). By default, the search
results display according to their Relevancy ranking, which means the
records most likely to be relevant to your search string display at the top
of the results.
See Quick Search Results for more information.

Search Options (wrench icon)
When searching a specific Business Object, select the wrench icon to
define options to refine the search: Changed, Open records only,
Relationships, Attachments, Sort By, etc.

Changed
Limit the search to records that have changed during a specific time
frame.

Open (records) only

Limit the search to records that have not reached their final state
(example: not closed). If the Business Object does not have a "final" or
closed state, this option is not available.

Note: The lifecycle and terminology vary depending on the
Business Object and scenario (examples: Unapproved Changes
only might appear when searching Changes, Non-Retired only
might appear when searching Knowledge Articles).
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Item Description

Search Related Items
Include related Business Objects in the search (example: If the search
word appears in a Journal entry, the Incident to which it is attached will be
included in the search results).

Search Attachments Return results that match the text within .txt, .doc, and .xls files and will
return any file type with a matching file name.

Sort by

Select the Business Object field (column) to use to sort the search results.
By default, the Search Results display according to their Relevancy
ranking, which means the records most likely to be relevant to your search
string display at the top of the results.
See Quick Search Results for additional information.

Ascending/Descending Sort the results in descending order instead of ascending order.

Search Manager Open the Search Manager, where you can create a Saved Search.
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Browser Client Toolbars
Browser Client toolbars are available when you are viewing records or dashboards.

Dashboard Theme Toolbar
The Dashboard Theme toolbar allows you to select a dashboard theme and refresh the current
dashboard.

Button Action Description

Select a Theme Applies a new theme to the current
dashboard.

Refresh the Dashboard Refreshes the current dashboard.

Record Toolbar
The Record toolbar provides actions you can perform when viewing records.

Action Description

Save Saves changes in the active window.

Cancel Cancels changes to the current record.

Refresh Refreshes the data for the current record.

Delete Deletes the current record.

Legal values Displays a list of legal values (for lookup fields only).

Unlocked
Locked by [user]

The record is unlocked.
The record is locked by [user].

Attach Attach (Import) Files to a Record.

Go to first record Navigate to the first record.

Go to previous record Navigate to the previous record.

Go to next record Navigate to the next record.

Go to last record Navigate to the last record.
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Action Description

Not queued
Add to queue

On [queue]

Check out

Check in

Remove from queue

The current record is not in a queue.
Add the current record to a queue.

The current record is added to [queue].

Check the current record out of the queue.

Check the current record back into the queue.

Remove the current record from the queue.

Current record View the current record.

List View records in a list.

Grid View records in a grid.
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Browser Client Menu Bar
Use the Browser Client menu bar to access CSM features, such as searches, One-Step Actions, and
email.

Table 1. Home

Action Description

Home Open the default dashboard.

Table 2. New

Action Description

New Create a new record (example: New Config - Mobile Device).

Table 3. Searches

Action Description

Search Manager Open the Search Manager, where you can run saved searches.

Quick Search Builder Open the Quick Search Builder, where you can create a quick
search.

Queues Open the Queues menu, including the Queue Manager and Most
Recently Used (MRU) queues.

Table 4. One-Steps

Action Description

One-Step Manager Open the One-Step Manager, where you can run One-Step Actions.

Recent Unassociated One-Steps Run the Most Recently Used (MRU) One-Step Actions.

Table 5. Email

Action Description

Send Email

Open the Email Message window so you can create and send emails.

Note: An email account must first be set up and given security
rights.

Email Current Customer

Open the Email Message window to create and send emails to a
customer's email address from your current page (example: an Incident
record or Problem record). The To line is automatically populated with
this address, and you are alerted if there is no active customer on the
record.
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Table 6. Dashboards

Action Description

Home Return to the default dashboard.

Dashboard Manager Open the Dashboard Manager, where you can view dashboards.

MRU See the Most Recently Used (MRU) dashboards.

Table 7. Pages

Action Description

Pages Manager Open the HTML Page Manager, where you can view HTML pages.

MRU See the Most Recently Used (MRU) Pages.

Table 8. Reports

Action Description

Report Manager Open the Report Manager, where you can run reports.

MRU See the Most Recently Used (MRU) Reports.

Table 9. Visualizations

Action Description

Visualization Manager Open the Visualization Manager, where you can run visualizations.

Config Visualization Open the Configuration Map Visualization.

MRU See the Most Recently Used (MRU) visualizations.

Table 10. Calendars

Action Description

Calendar Manager Open the Calendar Manager, where you can run calendars.

Main Calendar Open the main calendar, which is configured in CSM Administrator.

MRU Lists the Most Recently Used (MRU) calendars.

Table 11. Tools

Action Description

Contact Manager Open the Contact Manager, where you can view and manage
customer records.

Table Management
Open the Table Management interface, where you can manage
Lookup Table values. For more information, see Table Management
interface.

CMDB Open the CMDB interface, where you can manage Configuration
Items (CIs).
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Action Description

Network Health Check

If configured, runs the Network Health Check, a test to validate
network speed and connectivity.

For more information, see Network Health Check.

Related concepts
About Calendars
Contact Manager
CMDB Interface
Related tasks
Send an Email from within CSM
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Browser Client Account Information
Use the Browser Client account information options to change your language, open a new browser
window, log out, and access online help.

Table 1. User Information

Action Description

Languages Switch cultures to change the language for platform and content
strings.

New Browser Window Open the page in a new browser window.

My Profile View your personal information (contact information, manager
information, etc.).

Logout Log out of the current session.

Table 2. Help Icon / Company Information

Action Description

Help Icon
Access https://help.cherwell.com or a help site configured by your
organization.. For information on configuring a help site, see Configure
Global Help Settings.

Report Error

Submit information about an error you receive while working in CSM to
Cherwell. An administrator can configure a custom email address in
Global System Settings (CSM Administrator > Settings > Edit System
Settings > Help Settings).

(719) 386-7000
Cherwell phone number. An administrator can configure a custom phone
number in Global System Settings (CSM Administrator > Settings > Edit
System Settings > Help Settings).

<Version Number> See the version of CSM.

<Environment Type> Environment See the current system environment (Development, Production, or Test). If
an environment is not selected, the text does not display.

Cherwell Copyright CSM copyright information.
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Browser Client Managers
Browser Client Managers use tabs to navigate the areas where CSM items are located within each
Manager. The tabs correspond to folders in the Desktop Client and contain the same CSM items.

Select a tab to go to the items located in that file. Select an Item's Home takes you to the base file
structure (example: Dashboards>Pinboard, User, Role, Team, Global).

In the Browser Client Managers, you can:

• Run/Display: Run or display the selected item (example: Run a saved search, One-Step™ Action,
or report; display a dashboard).

• Filter (Association or Status): Filters items by record type (Incident, Problem, Change, etc.) or
status for the Queue Manager.

Note: Filtering by record type is only available in the Search, One-Step Action, Dashboard,
and Report Managers.

• View: View a list of available items in either list view or icon view.

• Search: Searchethe Item Manager for the provided word or phrase. Use the drop-down list for
recent searches. Clear the search by clicking on any tab under the Item's Home.
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CSM Client Feature Parities and Differences
The main Business Objects available in the CSM Desktop Client are also available in the CSM Browser
Client. The majority of the differences in functionality are in configuration and administrative functions
within the Browser Client.

Features CSM Desktop Client CSM Browser Client Differences

Actions Yes Partial In CSM Browser Client, run only.

Attachments Yes Extended

In CSM Browser Client, users can
download multiple attachments at once
and use drag-and-drop to add
attachments to records. The
Attachments tab of the Related Items
pane is only available in the Browser
Client.

Attachment
Manager Yes No

The Attachment Manager is not
currently supported in the CSM
Browser Client.

Automation
Processes Yes Partial

Run based on conditions met in any
client. Ability to view Automation
Processes for a current record
available in CSM Desktop Client.

Business
Hours Yes Partial In CSM Browser Client, view only.

Business
Object records Yes Yes View, create, edit, and delete Business

Object records.

Calendars Yes Partial In CSM Browser Client, view only; in
separate tab (not Tools).

CMDB Yes Yes

Contact
Manager Yes Partial In CSM Browser Client, view and

export only.

Execute a
Command
Actions in One-
Step™ Actions

Yes Partial In CSM Browser Client, some Execute
a Command Actions do not work.

Counters Yes Partial In CSM Browser Client, view only.

Dashboards Yes Partial

In CSM Browser Client, view only.

Users can change a dashboard theme
and refresh dashboards so widgets
display the latest data.
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Features CSM Desktop Client CSM Browser Client Differences

Email Yes Yes

In CSM Browser Client, see Related
Items Email, send email, and with
attachments. Configuration must be
done in CSM Administrator.

Expressions Yes Partial In CSM Browser Client, view only.

Forms Yes Yes

Grids Yes Yes

In CSM Browser Client:

• Actions, columns, and export
functions are found in the toolbar
instead of context menus.

• Grids automatically collapse to a
vertical card view on smaller
screens or resized browsers.
Filters and sorting are not
available in this view.

• The Truncate long fields option
is not available when exporting a
grid.

• Grid filters do not persist from
session to session.

HTML Pages Yes Partial In CSM Browser Client, view only.

Journals Yes Yes

Knowledge Yes Yes

Metrics Yes Partial

In CSM Browser Client, view only.
Caching differences:

• CSM Browser Client: Metric
query results are cached on the
server.

• Desktop Client: Metric query
results are cached on each
user's local machine.

To learn how this impacts results, see
Metric Caching.

One-Step
Actions Yes Partial

In CSM Browser Client, run only.

When a One-Step Action executes in
the CSM Browser Client, a progress
bar is not displayed.

Prompts Yes Partial In CSM Browser Client, run only.
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Features CSM Desktop Client CSM Browser Client Differences

Queues Yes Partial
In CSM Browser Client, view only;
Queue Manager in Searches (not
Tools).

Record
Locking Yes Yes  

Related Items
• Chat

• Communication

• Attachments

• Chat

• Communication

• Solution Search

• In CSM Desktop Client, Chat and
Communication only.

• When you add a new record to a
Business Object where the
Related Item Navigation has a
custom label expression for an
aggregate count of related
records on a tab or related item,
the count value is updated to
reflect the number of records
found in that relationship query.
In the CSM Portal and Browser
Client, the count value is correct,
but the records themselves do
not appear in the Related Items
pane. Once you save the record,
the Related Items pane displays
the records as expected.

Reports Yes Partial In CSM Browser Client, run only; in
separate tab (not Tools).

Rich Text Yes Yes  

Searching Yes Yes

System
Analyzer Yes No In CSM Browser Client, not currently

supported.

Table
Management Yes Partial In CSM Browser Client, view and

export only.

Task Pane Yes Alternative
In CSM Browser Client, use Related
Items Solution Search for similar
search functionality.

Toolbars Yes Partial
In CSM Browser Client, no ability to
create a custom toolbar or use the
toolbar created in CSM Desktop Client.

Visualizations Yes Partial

In CSM Browser Client, view only.

Also, the Browser Client Visualization
window does not include a menu bar.
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Features CSM Desktop Client CSM Browser Client Differences

Widgets Yes Partial

In CSM Browser Client, view and drill-
down only.

Note: Actions on Twitter
widgets are not supported in
the CSM Browser Client.
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One-Step Actions in the Browser Client
The One-Step Actions accessed and run in the Browser Client are created in the CSM Desktop Client or
in CSM Administrator. One-Step Actions cannot be created, edited, or deleted in the Browser Client.

In the Browser Client, users can run One-Step Actions from:

• The menu bar (run from the One-Step Action Manager or the list of Most Recently Used (MRU)
One-Step Actions).

• Buttons, links, and widgets on dashboards.

• Business Object records (as buttons or links). Some One-Step Actions might also run as Automatic
Actions that are executed when a Business Object is saved.

• The One-Step Action Manager (accessed from the menu bar).

• An Actions menu on a grid.

Good to know:

• When One-Step Actions execute in the Browser Client, the interface appears as disabled until the
One-Step Actions complete.

• Print Actions are supported in the Browser Client and Portal when Trusted Agents are used to run
the Actions. This includes Run a Report Actions that are configured to print a report. SaaS
customers can configure a Trusted Agent to use printers on their remote network; on-premises
customers can configure a Trusted Agent to use printers on their local network or on a remote
network. If you do not configure Trusted Agents, users receive an error indicating that Print Actions
are not supported when the One-Step Actions is run on the Browser Client or Portal.

• When One-Step Actions that contain multiple Actions are executed in a CSM web application, the
end result of the One-Step Action is shown to users when execution is complete. Users are
prompted for input as needed, but if the Save Business Object After Action check box is cleared
for a particular Action, changes made by the Action are not saved.

• There is currently no option in the Browser Client to run a One-Step Action for a group. You can,
however, configure a One-Step Action to run against a specific saved search. In this case, the One-
Step Action runs against the defined group of records, regardless of the client used to run the One-
Step Action. For more information, see Define the Conditions for a One-Step Action.

• Write file, read file, run program, and transfer attachments (to or from a file system) One-Step
Actions generally works for the CSM Browser Client, but the One-Step Action must be designed to
write an accessible file on the server, and then execute a program on the server using the contents
of that file. This requires configuring IIS security rights specifically to handle this capability.

• When a One-Step Action executes in the CSM Browser Client, a progress bar is not displayed.•
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CSM Browser Client Good to Know
Use these tips for helpful information on the CSM Browser Client.

• Some features behave differently in the Browser Client than they do in the Desktop Client. See CSM
Client Feature Parities and Differences.

• The Browser Client menu bar collapses into a hamburger menu on mobile screens and browser
windows sized below 768 pixels. It cannot be configured, but the CSM Items accessed from the
menu bar are driven by configurations and personal settings in the Desktop Client. For example, a
saved search can be created and saved in the Desktop Client, and then used in the Browser Client.

• The Browser Client consumes a CSM license. Licensing controls how many users can log into CSM.
CSM uses a concurrent or "floating" licensing model. This means that a fixed number of licenses are
shared among a group of users/customers, and that a fixed number of people can simultaneously
access the product. License codes determine the number of people who can log in at any given
time.

• Some forms have a special browser view. This means some information in a form is displayed (such
as client name), while other sensitive or secure information (such as social security number) is
blocked out. While this is predominantly the case with the CSM Portal, the Browser Client can be
configured to do this through CSM Administrator.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (Security > Edit Security Groups). For more information, see
Configure Browser and Mobile Device Security Rights.
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Use the Browser Client
Use the Browser Client to access most of the features available in the CSM Desktop Client.

For example, when working with the Browser Client, you can:

• Log records.

• View and run Searches and access queues.

• View and run One-Step Actions.

• Send emails.

• View dashboards and widgets.

• View HTML pages.

• View and run reports.

• View visualizations.

• View calendars.

• Access Knowledge Articles.

• Scan and search for barcodes.

• Use tools: Contact Manager, Table Management interface, and CMDB interface.
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Log in to the Browser Client
Before accessing the Browser Client, the appropriate credentials must be assigned. Credentials are
managed on the User's Profile in CSM Administrator.

To log in to the Browser Client:

1. Provide the URL: http://server/CherwellClient where server is the location where CSM is installed
(either locally on the machine or on a specific server outside the local machine).

2. Provide the login credentials (User ID and Password). These should have been assigned by the
implementer or system administrator.

Note: If Windows/LDAP login is enabled, provide the Windows credentials used to log in to
the system.

3. Click Login.

If assigned to more than one CSM Role (and have not previously selected the Automatically Use
Selected Role check box), the Choose your Role window opens.

Note: A Role is a User/Customer's current function/responsibility in CSM, and controls how
data is presented in that person's CSM environment. For example, a Role determines which
Home Dashboard is displayed and how the Incident form looks (example: Which fields are
exposed, required, etc.). A Role is assigned to a Security Group and can be assigned to
more than one Security Group at a time. A User/Customer can access any of the Roles in
his Security Group, but can only log in using one Role at a time. Examples of Roles include
Service Desk Manager and Portal Customer.

4. Select the login Role for the session:
a. Role: Click the appropriate Role.

b. Always Use Selected Role: Select this check box to automatically use the selected Role at the
next log in. This bypasses the Role prompt.

5. Click Submit.
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Log a Record in the CSM Browser Client
Browser Client records are very similar in appearance and functionality to Desktop Client records.

To log a record in the Browser Client:

1. Log in to the Browser Client.

2. On the Browser Client menu bar, select New.

3. Select the type of record from the drop-down (example: New Incident). The record opens in the
main pane.

4. Complete using the appropriate workflow and save the record.
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Search for Knowledge in the Browser Client
Users can search Knowledge Articles from an open record and place found solutions within the record for
future reference.

To search for Knowledge from an open record:

1. Open the record for which you want to find a solution.
2. Select theKnowledge button on the toolbar.
3. Select the Source of the Knowledge Article (known errors, open Incidents, Knowledge Articles, or

attachments). For attachments, the search returns results that match the text within .txt, .doc,
and .xls files and will return any file type with a matching file name.

4. Specify a word or phrase to search.
5. Select Search.
6. Select a Knowledge Article to view.
7. Select the Use Solution button to place the Knowledge Article information into the record.
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Resize Forms Using Splitters
In the Browser Client and Portal, Forms contain splitters that help users resize the Form Arrangement
using both horizontal and vertical splitters.

Good to know:

• In an open record, the horizontal splitter above the Form Arrangement (child object tabs) adjusts the
overall height of the Form Arrangement. The vertical splitter in the middle of the Form Arrangement
adjusts the overall width of the Form Arrangement if the tab features more than one section.

• Adjust the Form Arrangement by clicking anywhere on the splitters except for the Show/Hide Form
Arrangement arrows and the Show/Hide Child Object Details arrows.

• The splitter location defaults to the setting for that form, as defined in the Business Object Form
Arrangement Editor. After adjusting the splitter location, the new location will be saved and used for
that Business Object until the browser tab or window closes. After opening the site and logging in
again, the splitter location will default back to the placement settings for the form for that Business
Object. This setting does not persist across browsers.

There are several buttons and icons featured in the form splitters.

Button/Icon Action Description

Or Show or Hide Form
Arrangement

Shows a currently hidden Form Arrangement or hides a
currently visible Form Arrangement.

Or
Separators Indicates that the splitter bars can be dragged-and-dropped

where needed.

Or Show or Hide Child
Object Details

Shows the child object, including details or additional forms,
or hides the child object details or additional forms so only the
child object Grid is visible.

To show or hide the Form Arrangement:

• Click the Show Form Arrangement arrows to show a currently hidden Form Arrangement.
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To expand the Form Arrangement so that it fills the full area of the record, click the Show Form
Arrangement arrows a second time.

• Click the Hide Form Arrangement arrows to hide a currently displayed Form Arrangement.

To hide the Form Arrangement after expanding it to fill the entire area of the record, click the Hide
Form Arrangement arrows twice: once to return the Form Arrangement to its original size, and then
again to hide it completely.

To adjust the overall height of the Form Arrangement:

• Click and hold the horizontal splitter above the Form Arrangement and then move the horizontal
splitter up or down until the Form Arrangement is the desired height.

To show or hide a child object's details or additional forms:

• Click the Show Child Object Details arrows to show both the child object (example: Task) and its
additional details or forms (example: Task form).

To expand the child object's additional details or forms on the right-hand side of the Form
Arrangement space, click the Show Child Object Details arrows a second time.

• Click the Hide Child Object Details arrows to hide the additional details or forms.

To hide the additional details or forms after expanding them to fill the entire area of the Form
Arrangement, click the Hide Child Object Details arrows twice: once to return it to its original size,
and then again to hide it completely and only display the child object's Grid.

To adjust the overall width of the child objects and their details or additional forms:

• Click and hold the vertical splitter in the middle of the Form Arrangement and then move the
vertical splitter left or right until the child object and its details are the desired width.
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Add and Remove Columns from a Grid in the
Browser Client

Use the Column Selector in the Browser Client to add or remove columns from the Grid.

1. Open a Grid using an applicable feature.
2. Click the Columns button on the Browser Client toolbar.

The Column Selector opens displaying the Business Object's relationships and associated fields.
Relationships and fields currently displayed in the Grid are indicated by a check mark. Close the
Column Selector at any time by clicking the Cancel button.

3. Add columns to the Grid by selecting one of the following:
◦ The check box next to one or more Relationships in the top level of the tree (example:

Incident Links Customer) to add all fields associated with the Relationship as columns in the
Grid.

◦ The check box next to one or more fields in the second level of the tree (example:
Department, Manager) to add only the field(s) you select as columns in the Grid.
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4. Remove columns from the Grid by deselecting one or more check boxes in either the top level or
second level of the tree.

5. Click the Submit button.
If you added columns, the associated field(s) display on the right side of the Grid and can be moved
anywhere in the Grid by dragging-and-dropping the column to the desired location.
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Search in the CSM Browser Client
The Searches option in the CSM Browser Client main menu behaves very similarly to those in the CSM
Desktop Client.

These search behaviors include:

• Use the Search Manager to create, edit, and delete saved searches or use the Quick Search Builder
to create and run a one-time search. Both are accessed via the Searches drop-down list on the
menu bar.

• Queues can be run from the Queue Manager in the CSM Browser Client, but cannot be created,
edited, or deleted. The Queue Manager and MRU Queues are accessed via the Search drop-down
list on the menu bar.

Good to Know:

If a Business Object has been previously applied to your system as part of a Protected mApp™ Solution:

• You see a shield icon next to each content-protected search.

• You can't edit or delete a content-protected search.

• See Protected mApp Solutions.

To run a search:

1. From the CSM Browser Client main menu (for more information, see Browser Client Menu Bar),
select the Searches drop-down list.

2. Select an option from the drop-down list:
◦ Search Manager: Create and/or run a defined search.

◦ Quick Search Builder: Create and run a quick search.

◦ Queues: Select and run a queue from the Queue Manager.

◦ Download Power BI Data Connector: Download the Power BI Data Connector to use with
third-party reporting tools. For more information, see Using Search Data with Third-Party
Reporting Tools.

The results display in the Main Pane.

If card view is enabled for a Business Object, search results are displayed as medium or large
cards. To view a specific record in card view, select an item from the results list or the title link in a
card.

In card view, you can access:
◦ Navigation: Use page numbers and arrow buttons that allow you to navigate between pages

of results.

◦ Side menu: Access options, such as showing the currently selected record or showing results
in a grid view, sorting results by a field in ascending or descending order, and changing card
size.
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Note: To ensure that card size selections persist and do not revert to the default,
uninstall WebDAV in Internet Information Services (IIS).

◦ Ellipsis: Access a menu of actions available for the Business Object. Actions can be run
directly from the card view without drilling down into a record.

When viewing the Search results, more options become available in the Search menu drop-down list that
allow users to edit the current search and save the current search.

Related concepts
About Roles
Scope
Protected mApp™ Solutions
Protected mApp™ Solution FAQs
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Send Email in the Browser Client
You can send an email from the Browser Client multiple ways:

• Select Email > Send Email in the menu bar from anywhere in the Browser Client. You select the
recipients when using this option.

• Select Email > Current Customer in the menu bar when a Business Object record is active.

• Select an e-mail address on a Business Object record.

• Run a One-Step Action configured with an email Action directly from the One-Step Action Manager.

Note: Emails are sent from a defined default account. If you have not configured e-mail for CSM,
see e-mail accounts documentation.

CSM 2022.3 Client Suite 86

CSM 2022.3 Client Suite

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=about_csm_e-mail_accounts


Scan a Barcode

Note: It's important to have good lighting in order to properly capture the barcode.

1. Launch the BarcodeScan command on a Business Object form or from the CMDB.
Your mobile device camera will be activated.

Note: If you click Don't Allow, you will be returned to the Business Object form.

2. Scan the barcode with your mobile device camera.
Instead of scanning the barcode, you can manually enter it in the Value field of the BarcodeScan
attribute.

3. Complete the required fields and click Save.

Related concepts
Configure the Browser Client to Scan Barcodes
Related tasks
Search for a Barcode
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Search for a Barcode
You can search for a barcodes in CSM's Configuration Management Database (CMDB). The barcode can
either be manually entered in the search field, or from the barcode scanner. Launch the barcode scanner
by clicking Scan Barcode.

Related concepts
Configure the Browser Client to Scan Barcodes
Related tasks
Scan a Barcode
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Configure the Browser Client
Browser Client configuration steps are completed in CSM Administrator.
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Configure CSM Web Application Settings (URLs,
Timeouts, RSS Feeds)

Use the Browser Application Settings window inCSM Administrator to configure web application
settings.

You can:

• Define URLs to the Browser Client and CSM Portal.

• Set session timeout. In CSM Browser Client and CSM Portal, users are given a warning two minutes
before the specified timeout is reached, with an opportunity to remain logged in. If they do not
choose to remain logged in, they are logged out when the timeout is reached.

Tip: We recommend setting the session timeout to 90 minutes. You will also need to
configure the application pool in IIS to have a value of at least 5 minutes greater than the
session timeout. CSM cannot make this change directly.

• Enable or disable embedded frames, choose to send detailed error information to the client, control
linked attachments (attachments via links instead of direct file attachment), and disable password
auto-complete.

To configure web application settings:

1. In CSM Administrator, open the Browser Application Settings window (Browser and Mobile >
Browser Application Settings).

2. Configure URLs that are used to generate a URL for launching one of the web applications
(example: when sending out approvals).

◦ Specify the base URL for the CSM Portal (example: https://MyServer/CherwellPortal).
◦ Specify the base URL for the CSM Browser Client (example: https://MyServer/CherwellClient).

3. Set a Session Timeout, which is the number of idle minutes the system should wait before timing
out inactive sessions.

4. Configure web application security settings:
◦ Select the Do not allow the browser applications to be embedded in a frame check box to

disable web applications from being embedded within the frame of another web page.
◦ Select the Do not send detailed error information to client check box to prevent the web

applications from sending detailed error information when errors occur.
◦ Select the Disable linked attachments in the browser applications check box to disable

attachments created from links instead of direct attachments.
◦ Select the Disable password auto-complete on login page check box to disable auto-

complete for passwords during login. This requires users and customers to type their full
passwords every time they try to log in to the web applications.

5. Select OK.
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Define the Default Domain and Anonymous Login
Settings

By default, if using Windows or Active Directory, Users must specify the domain as part of the login
credentials (example: Applications\Bob).

Specifying the domain is how CSM identifies the fact that Users are specifying Windows/LDAP credentials
vs. internal Cherwell credentials. However, if all Cherwell Users are generally on the same domain,
specify that as the default domain. The Cherwell Portal automatically assumes that any credentials
detailed without a specific domain are Customers of the default domain.

Use the General page in the Security Settings window (in CSM Administrator) to define the following
general system security settings for the CSM Browser Client and Customer Portal:

• Default domain

• Anonymous login settings

Configure the default domain and anonymous login settings:

1. In the CSM Administrator main window, select Security > Edit security settings.

2. Select General.
3. Specify a default domain for the network:

a. Default domain: Specify the default domain name for the network. The domain is used in any
place where a domain is needed but not otherwise provided, such as automatically assigning
credentials to Customers.

Note: Select Arrow ( ) to have CSM auto-populate the name.

4. Configure anonymous login settings:
a. Allow Anonymous Login: Select this check box to allow CSM Web Applications to read basic

setup information from the system without User login and to enable the Anonymous Security
Group access to items specifically configured for Anonymous view.

b. Security group when not logged in: Select the Anonymous Security Group (OOTB:
Anonymous Browser) that should be used by CSM Web Applications before any User/
Customer has logged in.

5. Select OK.
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Configure Login, Authentication, and Inactivity
Settings for the CSM Portal and CSM Browser
Client

By default, the CSM Web Applications (Browser Client and CSM Portal) use the same login mode and
authentication settings as those configured for the Desktop Client; however, users can define different
settings if needed.

To configure login, authentication, and inactivity settings for the Browser Client and CSM Portall:

1. In CSM Administrator, select Security > Edit security settings.

2. Select Browser Client or Browser Portal.
3. Clear the Use Same Settings as Desktop Client checkbox.

4. In the Supported login modes section, select the login modes that you want to support:

Note: Users can enable multiple login modes so if one authentication fails or the user/
customer cancels the process, the next configured login method is invoked (SAML, then
external authentication server, then LDAP, then Windows, then Internal). Not all of these
options will appear in the system if they have not been configured.

When you use a secure login configuration (SAML, LDAP, or Windows), we strongly
recommend that you activate the RedirectHttpToHttps flag in the CSM Portal and Browser
Client for better security. The flag forces requests sent over HTTP protocol to use HTTPS
instead.

◦ Internal: Allows CSM authentication. CSM authenticates the CSM Login ID and Password
defined in the CSM Administrator User Profile (Security > Edit Users) or Customer
Credentials (Customer > Portal Settings).

To use internal login credentials on a default domain, users must type CHERWELL\ in front of
the user name (example: CHERWELL\Bob) to be able to log in.

◦ LDAP: Allows Directory Service authentication. CSM authenticates login credentials using a
Directory Service such as LDAP or Active Directory. Depending on configuration, user/
customer data can be imported based on LDAP data.

◦ SAML: Allows Security Assertion Markup Language (SAML) authentication.

◦ Windows: Allows Windows Authentication. CSM authenticates the Windows login credentials if
set in the CSM Administrator User Profile (Security > Edit Users) or Customer Credentials
(Customer > Portal Settings).

5. Configure general login options:
a. Validate Windows/LDAP credentials on server: If you clear this checkbox, Windows credentials

are validated on the client, which is not as secure unless you have full control of your network.
If you select the checkbox, the system cannot automatically log in the user/customer without
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asking, (the user will have to type their credentials) but it is much more secure. For this feature
to work, the server must have access to the Windows Domain or LDAP server.

For best results, configure your server to use encrypted communication before enabling this
feature so that credentials are not passed to the server in a potentially sniffable format.

b. Allow logging of authentication code (for troubleshooting): Select this checkbox to enable
logging of authentication calls to troubleshoot configuration (example: When configuring LDAP
setup). Then, use the Server Manager to enable logging in the CSM Portal and Browser
Client.

6. Select OK.

Related concepts
Define the Default Domain and Anonymous Login Settings
Integration with Directory Services Workflow
About SAML
Windows Credentials
Related tasks
Prevent Browsing HTTP from HTTPS
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Prevent Browsing HTTP from HTTPS
Browse HTTP from HTTPS is a vulnerability allowing HTTPS pages to be accessed via HTTP, thus
disclosing potentially sensitive information. We strongly suggest enforcing the redirection of HTTP
requests to HTTPS via a setting in Overwatch.

To redirect HTTP request to HTTPS:

1. Use the Command-Line Configure utility to pass the following command to Overwatch. This
enforces redirection in the CSM Portal.

/updateportalsettings /redirecthttptohttps=true

2. Use the Command-Line Configure utility to pass the following command to Overwatch. This
enforces redirection in the CSM Browser Client.

/updatebrowserclientsettings /redirecthttptohttps=true

3. Reset IIS.
4. Review the configuration of any applications you have installed to ensure proper permissions are in

place to prohibit forceful browsing of HTTPS resources.
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Configure Anonymous Login Settings for CSM
Web Applications

Use the CSM Administrator Security Settings General page to configure the anonymous login settings for
CSM Web Applications.

To allow CSM Web Applications to read basic setup information from the system and to enable
Anonymous Security Group access to items specifically configured for Anonymous view:

1. Open CSM Administrator and select Security > Edit security settings.

2. Select General.
3. Configure anonymous login settings:

a. Allow Anonymous Login: Select this check box to allow CSM Web Applications to read basic
setup information from the system without User login and to enable the Anonymous Security
Group access to items specifically configured for Anonymous view.

b. Security group when not logged in: Select the Anonymous Security Group (OOTB:
Anonymous Browser) that should be used by CSM Web Applications before any User/
Customer has logged in.

4. Select OK.
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Configure Browser Client (User) Login Credentials
CSM uses a User's login credentials to log them into the Browser Client. Login credentials are stored in
the User Profile. This must be configured through CSM Administrator and cannot be done from the
Browser Client.
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Configure Miscellaneous Settings for Web
Applications

Several web.config files contain certain settings for the CSM Web Applications, including the Browser
Client, CSM Portal, and, in some cases, the Cherwell® REST API. These settings are handled by
Overwatch, and you can edit them using the Command-Line Configure utility.

For best results, restart Internet Information Services (IIS) after you modify web application settings. See
Overwatch Command-Line Options for more information on available Command-Line Configure options
for web applications.

Change Prompt Time-out Period
Prompts generated by a One-Step Action, expression, or stored search remain open in the web
applications for 2 minutes by default. If users do not respond to the prompt within that time frame, the
prompt closes.

To change the default time-out period for the Browser Client, use the Command-Line Configure utility to
pass the following command to Overwatch:

/updatebrowserclientsettings /UIInteractionTimeoutInSeconds={number of seco
nds}>
      

To change the default time-out period for the CSM Portal, use the Command-Line Configure utility to pass
the following command to Overwatch:

/updateportalsettings /UIInteractionTimeoutInSeconds={number of seconds}>
      

Disable Label Resizing

Note: We do not recommend disabling label resizing.

While not recommended, to disable the resizing of labels that are set to dynamically auto-size in the
Browser Client, use the Command-Line Configure utility to pass the following command to Overwatch:

/updatebrowserclientsettings /AutoSizeLabels=False

To disable the resizing of labels that are set to dynamically auto-size in the CSM Portal, use the
Command-Line Configure utility to pass the following command to Overwatch:
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/updateportalsettings /AutoSizeLabels=False

Disable Scripts in Reports
By default, users can run a report that contains scripts if they have rights to run the report. You can
disable scripts from running in all reports, however. This may cause errors when users run reports that
contain scripts, but may improve security.

By default, scripts are enabled for reports.

To disable scripts in all reports in the Browser Client, use the Command-Line Configure utility to pass the
following command to Overwatch:

/updatebrowserclientsettings /allowscriptsinreports=false

To disable scripts in all reports in the CSM Portal, use the Command-Line Configure utility to pass the
following command to Overwatch:

/updateportalsettings /allowscriptsinreports=false

Execute Embedded HTML and Script

Note: We do not recommend allowing embedded HTML and script.

To allow HTML and script embedded in labels to be executed in the Browser Client, use the Command-
Line Configure utility to pass the following command to Overwatch:

/updatebrowserclientsettings /AllowUnsafeLabels=True /AuthLogFile={filepath
}

To allow HTML and script embedded in labels to be executed in the CSM Portal, use the Command-Line
Configure utility to pass the following command to Overwatch:

/updateportalsettings /AllowUnsafeLabels=True /AuthLogFile={filepath}

HTTPS-Only Cookies
In production environments, we strongly recommend that sensitive cookies (like those used to maintain
your session) be marked as "Secure," meaning they will only be transferred with requests that are made
over HTTPS, and HTTP-only. They will not be accessible to Javascript running in the browser.

In order to take advantage of this configuration, perform the following steps:
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1. Ensure the web application is running on an IIS instance that listens on both :80 (HTTP) and :443
(HTTPS).

2. Ensure IIS (or a web.config file, or some other handler) is set up to automatically redirect http://
hostname/path to https://hostname/path.

3. Add the following line to these web.config files:
◦ C:\Program Files\Cherwell Browser Applications\Portal

◦ C:\Program Files\Cherwell Browser Applications\CherwellClient

◦ C:\Program Files\Cherwell Browser Applications\CherwellService

<httpCookies
httpOnlyCookies="true"
requireSSL="true" />

For more details, see https://msdn.microsoft.com/en-us/library/ms228262(v=vs.100).aspx.

In-line Browser Display Extensions
To specify other in-line browser display extensions that should open inside of a browser window in the
Browser Client, use the Command-Line Configure utility to pass the following command to Overwatch:

/updatebrowserclientsettings /InlineBrowserDisplayExtensions={.pdf or .xml 
file name}

To specify other in-line browser display extensions that should open inside of a browser window in the
CSM Portal, use the Command-Line Configure utility to pass the following command to Overwatch:

/updateportalsettings /InlineBrowserDisplayExtensions={.pdf or .xml file na
me}

Note: Browsers that are not Microsoft Edge (example: Chrome™, Mozilla Firefox®, etc.) handle
in-line browser display extensions more automatically, but Edge requires this to be set. PDF and
XML files are handled this way by default.
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Configure the Browser Client to Scan Barcodes
You can configure the CSM Browser Client to enable users to scan asset barcodes using the camera on a
mobile device.

Through the CSM Browser Client, you can use a mobile device camera as a barcode reader to scan asset
tags and upload photos to tickets.

The following types of barcode readers are supported:

• Code 128: code_128_reader

• EAN: ean_reader

• EAN-8: ean_8_reader

• Code 39: code_39_reader

• Code 39 VIN: code_39_vin_reader

• Codabar: codabar_reader

• UPC: upc_reader

• UPC-E: upc_e_reader

• Interleaved 2 of 5: i2of5_reader

• 2 of 5: 2of5_reader

• Code 93: code_93_reader

Prerequisite: Before users can scan barcodes from within the CSM Browser Client, you must add the
BarcodeScan attribute to the Business Object and add a field to store the barcode value.

Add the BarcodeScan Attribute
To add BarcodeScan to the Business Object for a Configuration Item:

1. In CSM Administrator, create a new or edit an existing Blueprint.

2. Select a Business Object, such as Config - Server.
3. In the right pane, under Structure, select Edit Business Object.
4. Select Bus Ob Properties.

5. Select Advanced, then select the down arrow ( ) next to General attributes.

6. In the Attribute field, enter BarcodeScan.

7. Do one of the following:
◦ Leave the attribute value blank; the system will use all the barcode reader types specified

above.

◦ Specify the barcode reader types you want to support as a comma-delimited list in the attribute
value field: This increases scan reliability.
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Note: Barcode reader types can only be set at the Business Object level.

8. Select OK.

Add a Field to Store the Barcode
To add a field to store the barcode:

1. Open the Business Object that has the BarcodeScan attribute, and then:
a. Add a new field or select an existing field.

b. Open the Field Properties window.

c. Select Advanced, then select the down arrow ( ) next to General attributes.

d. In the Attribute field, enter BarcodeScan.

e. Select OK.

2. Under Appearance, select Edit Form.

3. Drag the type of control you want to use onto the form, then right-click and select Control
properties.

4. Select Commands > Other.
5. Select the ScanBarcode command, and add it as the command for a control to launch the barcode

scanner. The result will appear in the Barcode Field on the form.

6. Select OK.
You can now launch the barcode scanner from a Business Object form.

Once you have set up the BarcodeScan attribute in the Business Object and added a field to store the
barcode, you can use it to enable scanning from a mobile device.

Related tasks
Scan a Barcode
Search for a Barcode
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Set the Location of a Business Object
In the Browser Client, the current location of any Business Object can be set automatically, through
location services, or manually, so that you know its location and can access it when necessary.

To set the location of any Business Object:

1. In CSM Administrator, create a new blueprint or open an existing blueprint.
2. Select a Business Object, such as Configuration Item > Computer. You can add the Location

attribute to any Business Object.
3. In the right pane, under Structure, select Edit Business Object.
4. Click Bus Ob Properties.

5. Select Advanced, then select the down arrow ( ) next to General attributes.
6. In the Attribute field, enter LocationAware. The Value field can remain (null).

This makes the Business Bbject location-aware.
7. Click OK.
8. Add the Lattitude, Longitude, and Altitude attributes to any single Field in your Business Object:

a. In the Business Object Editor, select any Field in the list, then click Field Properties.
b. Select Advanced.

c. Select the down arrow ( ) next to General attributes.
d. In the Attribute field, enter LocLatitude.

The location data will be stored in the Value field.
e. Repeat steps a - d for Longitude (LocLongitude) and Altitude (LocAltitude).

Note: Altitude (LocAltitude) is only supported on mobile phones and tablets.

Optional: You can also edit the Business Objects Form to add controls for these fields. For more
information, see Forms.

Expressions
Latitude and Longitude Fields can also be added to Expressions or One-Step Actions so you can use
them in mapping software such as Google Maps. Use a text Expression on a link label or a button
associated with an Action and use the documented URL. For example, if you use Google Maps, the URL
will be something like https://www.google.com/maps/search/?api=1&lat,long. Add the Fields
for lat,long into your Expression or One-Step Action.
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CSM Portal
The CSM Portal is a highly configurable web application that enables customers to securely and
conveniently access their CSM data using a browser. The CSM Portal supports multiple sites, and also
allows managers to access their team’s data.
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About Customer Portals
Customers can perform several tasks when using a CSM Portal.

• Access a Service Catalog.

• Log Incidents and Service Requests.

• Complete common self-service functions (example: Reset a password).

• Access Knowledge Articles.

• Access a document repository, if configured.

• Monitor important metrics via a dashboard.
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A Portal comprises one or more configurable Portal sites, each of which can display completely different
information. For example, there might be a primary IT site, but also different sites for other departments or
functions. Any particular site can be made up of a number of site items.

Several starter Portal sites are available to you. These include Portal-specific forms, dashboards, and
more. For example, CSM provides a IT Services Management (ITSM) Portal Site. The site is built using
OOTB site items, such as a Service Catalog, forms specific to the Portal, dashboards specific to the
service desk, and predefined properties (header/footer, menu bar). You can implement and use any
OOTB IT Portal Site as provided, modify it, or create new sites to meet the needs of your organization.

Related concepts
Portal Sites
Site Items
OOTB IT Portal Site
Portal Site Design Ideas
Create a Custom Portal
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Portal Sites
A Portal site is a collection of self-service information in a CSM Portal that is dedicated to a topic or
function.

A Portal can display one or more sites. For example, it might display:

• A company support site (single site Portal).

• A site for each department (HR, Facilities, Support).

• A site for each locale (US, Germany, Chile), although a single site can be configured to be available
in multiple languages.

A Portal site is highly configurable and can be tailored to meet branding and layout needs. The site can
display an application bar (Login, Site Selector), an informative banner/footer, a menu bar, a search
control, and a startup item (example: A dashboard).
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1. Banner: Displays site and background image, title, subtitle, and baseline text.

2. Application Bar: Displays the Language Selector, Site Selector, Login menu, and Help menu.

3. Menu Bar: Lists the site Items and/or supporting Actions. Select a site item to display its contents
in the main pane or its list of supporting Actions. The Portal menu bar collapses into a hamburger
menu on mobile screens and browser windows sized below 768 pixels.

4. Main Pane: Displays the Startup Item, which could be a dashboard, a report, a list of records, or the
record currently being edited.
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Site Items
When creating a Portal, add site items to be displayed on the site menu bar.

The following items can be included on a Portal site:

• Actions (including powerful create options and interactive One-Step Actions): Use on a site's menu
bar to support site items (Create Incident or Display Document Repository) and enhance navigation.
Actions can also be used on dashboards and HTML pages.

• Action Catalogs: Display a self-building and dynamic catalog of Actions that empower customers to
help themselves (example: Create a Service Catalog that displays all your services with Actions to
create Incidents and Service Requests).

• Calendars: Displays time-sensitive Business Object data in a calendar format.

• Dashboards and Widgets: Provide custom, insightful control panels capable of executing
commands and providing real-time, at-a-glance information. For example, a customer-specific
dashboard complete with a Twitter Feed, a list of announcements, and a list of open/closed
Incidents.

• Document Repositories: Provide a collection of resourceful documents, such as Knowledge
Articles, that encourage customers to resolve their own issues.

• Forms/records: Allow customers to expedite service by creating, viewing, and editing their own
records, such as Incidents and Service Requests, and possibly other customer's records.

• Grids: Allow customers to view CSM data from a Business Object in a format that can be sorted
and exported.

• HTML Pages: Display a system administrator-designed HTML-coded page or host a web page from
an external site.

• Knowledge: Search for Knowledge Articles (KAs) using a Portal site's configured search control.
When using a KA in the Portal, customers can vote on article popularity by selecting the Like button
and add feedback by selecting the Add a Comment link.

• Reports: Provide metrics of your record data in a formatted and organized presentation.

• Searching: Offers searching so that customers can easily locate information about the Portal. Use
CSM's supplied search control or create your own search widget.

• Service Cart: Provides an e-commerce tool that customers can use to add multiple services to a
single order, and then temporarily hold the services until they are ready to submit their order.

• Visualizations: Display a visual map of linked records, customers or vendors.

Note: HTML pages are unique to the Portal. The other items are commonly used throughout
CSM.

When a customer first accesses a site, a default Startup Item is displayed; this can be an Action Catalog
(special widget), a dashboard, a document repository, an HTML page, a report, or a saved search (used
to display a list of records). A customer can access other site items using the site menu bar. The Startup
Item can also be accessed when users select the optional title logo/text or optional Home menu bar
button.
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Different startup items can be displayed upon login so information can be securely and appropriately
filtered based on credentials. For example, display a Service Catalog to customers who are not logged in
and then display a dashboard complete with a customer's Open Incidents for a customer who does log in.

To help build and manage the Portal and sites, CSM provides the Site Manager (manage sites at a high-
level), the Site Wizard (create a cursory site), and the Site Editor and Site Properties window (edit/refine
the way the site/site items look and behave). CSM also provides numerous CSM Item Managers that
allow you to create site items, such as dashboards, HTML pages, and document repositories.

Related concepts
Portal Sites
About One-Step Actions
Navigate CSM Portal Knowledge Articles
CSM Desktop Client Quick Search Widget
Create a Search Widget
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About Portal Actions
CSM provides several customizable Actions that can be added to and executed from the Portal menu bar,
a dashboard, or an HTML page.

An Action is an activity that can be initiated manually (from a button, link, menu bar item, or widget) or
automatically (from an Automation Process, One-Step™ Action, or Email Monitor) to execute a command
(example: Print) or display/run a CSM item (example: Display a dashboard or run a search).

Examples include:

• Display Create commands for the Business Objects used on the Portal site (example: Create
Incident).

• Display common searches (example: Search My Open Incidents).

• Display a Home button on the Portal menu bar to take customers back to the Startup Item.

• Display or run a CSM item (example: Action Catalog, report, document repository).

Some Actions are automatically added to the menu bar when creating a site using the Site Wizard. For
example, a menu bar Item can be added for each Business Object associated with the site and a
Document Repository Action is added if there is a document repository.

Manually add Actions or edit existing Actions by defining menu bar properties for a site.

Manually add the following Actions:

• One-Step Action: Runs a One-Step Action, which runs one or more other Actions:
◦ Create/update/delete a Business Object.

◦ Excel merge.

◦ Execute a command.

◦ Go to a field.

◦ Go to a record.

◦ Go to Action (branching).

◦ Launch a URL.

◦ Link/Unlink Business Objects.

◦ Print.

◦ Run another One-Step Action.

◦ Run a program.

◦ Run a report.

◦ Send a Tweet.

◦ Send an email.

◦ Show a pop-up.

◦ Step through children.
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◦ Transfer attachments.

◦ Transfer Related Business Objects.

◦ Update a variable or stored value.

◦ Web service call.

◦ Write to a file.

◦ Work with a queue.

• Command: Runs a system command applicable to the Portal. Categories include:
◦ Managers: Adds a command to launch a CSM Item Manager so that a customer can choose

a CSM Item (Action Catalog, dashboard, document repository, One-Step Action, HTML page,
report, or search) to open/run (example: Add the Report Manager to the site menu bar so that
customers can choose to run an available report). Note: Recent Items lists must be placed
inside folders (they cannot be at the top level of the menu bar), and it is recommend that they
be placed as the last item in the folder.

◦ (Other) Business Object Search: Provides common site searches (example: Business
Object to search, how the results should be sorted, whether to limit to the current customer, or
limit to open or closed records).

◦ (Other) Create Business Object: Creates a new Business Object (record) but with several
powerful options, such as a One-Step Action to run as part of the creation process and
whether a custom form should be displayed (which can be different than the supplied form
used for viewing a Business Object).

◦ (Other) Home: Takes the customer to the Startup Item (example: Dashboard, HTML page).

Note: This command must be placed in a folder.

• Dashboard: Displays a dashboard.

• Report: Runs a report.

• Search: Runs a saved search.

• Page: Displays an HTML page.

• Doc Repository: Displays a document repository.

• Action Catalog: Displays an Action Catalog (widget).

Related concepts
About One-Step Actions
About CSM Item Managers
Related tasks
Create a Site Using the Site Wizard
Define Menu Bar Properties for a Portal Site
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About Portal Action Catalogs
Use Action Catalogs in a CSM Portal so customers can select services from a Service Catalog.

When a customer selects a hyperlink, an Action executes (example: Request Account creates an Incident
record and categorizes it as a Request). The Action Catalog's theme, such as Cherwell Next, controls the
fonts, colors, and block layout.

Note: A Service Catalog is built using the Action Catalog widget, which can be used on a
dashboard or as a standalone widget in the CSM Portal.

Related concepts
Create an Action Catalog Widget
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About Portal Calendars
The CSM Portal has calendar capabilities that are very similar to those in the Browser Client calendar.

A calendar allows you to view time-sensitive Business Object data in a natural format that can be shared
with teams or an organization.

Examples of Portal calendars include the IT Calendar, Task Calendar, and Event Calendar.

When working with calendars In the Portal, users can:

• View a calendar by selecting IT Calendar on the menu bar.

• Change the Calendar View.

In the Portal, calendar functionality is accessed by selecting IT Calendars on the portal menu bar if you
designed the Portal to include it.

Related concepts
Change the Calendar View
Design a Portal
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About Portal Dashboards
A Portal dashboard is a custom, interactive, and insightful console that is optimized to provide helpful at-
a-glance self-service information and navigation for customers accessing a Portal site.

Like all CSM dashboards, a Portal dashboard uses configurable widgets to display critical metrics,
analyze and predict trends, drill down into data, initiate commands and Actions, facilitate navigation, or
show a sampling of information relevant to customers.

Examples of Portal dashboards include:

• A not logged-in Portal dashboard, intended for anonymous customers, that presents general
information and data, such as a welcome information, a community announcement board, and
service desk hours.

• A logged-in Portal dashboard, intended for logged-in customers, that displays a list of open records
(by customer and organization), facilitates navigation, and helps customers with self-service
operations (example: Logging Incidents, locating Knowledge Articles and FAQs).

• A department dashboard, intended for customers in a specific department (example: HR, Facilities,
Finance), that presents department-specific records and metrics, an announcement board, or a
Twitter Feed.

CSM provides several Portal dashboards, which are used with the OOTB Portal site(s). Use these
dashboards as provided, modify them, or create new dashboards using the Dashboard Manager and
Dashboard Editor.

Related concepts
Dashboards
About Widgets
OOTB IT Portal Site
Dashboards
Widgets
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About Portal Widgets
Use widgets on a Portal to display information for customers to see.

A widget is a mechanism that displays information about a dashboard or Portal site (example: Chart,
gauge, button). Examples of Portal widgets include:

1. Search Results List widget

2. Chart widget

3. Action widgets (links or commands)

CSM provides multiple widgets designed to display data on a dashboard or Portal site. Use these widgets
as provided, edit them, or create your own using the Widget Manager.

Related concepts
Dashboards
Portal Sites
Managing Widgets
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About Portal Forms
CSM allows you to create several different types of Portal forms for each Business Object.

Portal forms are regular forms designed specifically for the Customer Portal to provide self-service record
logging capabilities, such as an abbreviated Incident form. Typically, Portal forms are much simpler than
the default form used in the Desktop/Browser Client.

Regular forms are main forms or forms for the Business Object. By default, each Business Object has one
Default regular form; however, you can create as many as you need. Typically, a regular form is intended
for detailed logging activities in the Desktop and Browser Client.

Related concepts
About Customer Portals
About Forms
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About Portal Grids
Grids in the Browser Client and Portal look very similar to Desktop Client grids.

Portal grids include the following features:

• Grid Menu Bar: Displays actions available for the grid, including navigation, Actions, and available
columns.

• Title: Grid title that may or may not match the name of the Business Object that the grid represents.
Also, a Business Object might have multiple grids, so each may have its own name.

• Sort icon: Indicates the column currently sorting the grid, and if it is in ascending or descending
order. Select the icon to toggle sorting. Select another column heading to sort by that column.

• Filter icon: Indicates the column data can be filtered. Select the icon to show filtering options
(possible filter values appear in the column's Filter drop-down list).

• Grid item: Each item within a grid contains its own line of information. Selecting the item opens the
record in the Main Pane.
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About HTML Pages
CSM provides several HTML pages.

A CSM HTML page is an HTML-coded web-like page used to display information on a CSM Customer
Portal Site or in the CSM Browser Client.

HTML pages can be:

• Internal HTML pages: HTML pages that users design and code. Users can insert CSM commands
directly into the page, as well as CSM images, tokens, and stored values.

• External HTML pages: Existing websites; users supply the URL.

Use an HTML page to display:

• A company website as a Startup Item on a Portal site.

• A hardware website or forum on a Portal site (add an Action to a site menu bar to display an HTML
page).

• A hard-coded HTML page that users design directly in the Browser Client.

Use these supplied HTML pages as-is, edit them, or create new HTML pages using the HTML Page
Manager. CSM also provides the HTML Page Editor to help design and code your own internal HTML
page.

Note: The HTML Page Editor is useful for building pages. For more advanced options, it is
assumed that users have a working knowledge of HTML and possibly CSS.

Related concepts
About Portal Actions
Related tasks
HTML Page Editor
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About Portal Knowledge
CSM consolidates multiple knowledge sources into a single, powerful knowledge base so that users can
find relevant information quickly without the use of additional resources.

Depending on the configuration of your system, customers might also have access to knowledge through
the Portal so that they can independently solve issues.

CSM Knowledge can come from many different knowledge sources, including:

• Knowledge Articles (KAs): CSM Business Object dedicated to knowledge. Use to share identified
solutions with users and customers. Note that KAs can also be imported from third-party knowledge
providers.

• Business Object records: Closed Incidents or Problems (Known Errors), or any other appropriate
Business Objects.

• Attachments: Imported internal or external documentation.

• Web: Adobe®, Google®, Microsoft TechNet®, Twitter®, Yahoo!®, and YouTube®.

By default, only members of the Portal Workgroup Manager Security Group can create Knowledge
Articles in the Portal.
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In the Portal, customers can search for Knowledge Articles using a Portal site's configured search control
or using the Knowledge Article dashboard. When on a KA in the Portal, customers can vote on article
popularity by selecting the Like this Article link, note whether or not it resolved their issue by selecting
Yes or No, and add feedback by selecting the Add Comment link.

Related concepts
Knowledge Articles
About Security Groups
Navigate CSM Portal Knowledge Articles
Related tasks
Create a Knowledge Article in the Portal
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About Portal Reports
Portal reports behave similarly to reports in the Browser Client.

In the Portal, reports can be run from specific links and widgets in a dashboard (if configured in CSM
Administrator).
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About Portal Searching
CSM provides multiple search tools to help efficiently and thoroughly search and filter CSM data, locating
one record or a set or records.

Search tools for the Portal include:

1. Knowledge Search: A knowledge search is a search that runs against the Cherwell knowledge
base to quickly find solutions. Knowledge searches can also treat existing records in CSM as
knowledge sources. Search results display according to their Relevancy ranking, which means the
records most likely to be relevant to your search string display at the top of the results. On the
OOTB IT Portal site, the Find Help dashboard contains an Action link that opens the IT Portal Site
Knowledge Article dashboard. This dashboard displays a knowledge search bar as well as the
Featured and Most Popular Knowledge Articles.

Tip: To use a simpler search bar in your portal, see Render Mode in Create a Search
Widget.

2. View Service Catalog: Selecting View Service Catalog takes you to the Service Catalog where
you can run a search.
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Related concepts
About Knowledge Management
OOTB IT Portal Site
Create a Search Widget
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About the Service Catalog
The OOTB Service Catalog displays service catalog items with an icon (optional), title, and description in
card format.

Service catalogs can include:

• Account Management: Pertains to network access and passwords.

• Conferencing/Presentation: Encompasses conference setup, web sharing, projectors, and more.

• Desktop Management: Covers end-user computer equipment and OS, anti-virus, and
miscellaneous software.

• E-mail/Calendaring: Contains email and calendaring software and account management.

• Employee Support: Used primarily by HR and hiring managers to set up new employees, update
their information, or request an employee separation task.

• Enterprise Apps: Contains options for business software used by the organization.

• IT Service Desk: Used primarily by an IT department to manage technology systems in the
organization.

• Network Services: Covers the network itself, both wired and wireless. It includes file sharing and
backup/restore services.

• Printing: Covers local desktop and shared network printers. Users can request access to network
resources, request toner/ink, or request a local printer of their own, pending approval.

• Telephony/Fax: Covers telephony equipment (desktop and mobile) and fax machines.

• Web Services: Includes external (Internet) and internal (Intranet) requests.

The OOTB Service Catalog has a search feature that produces a list of suggested matches after typing
three characters into the search box. You can search on the title and description of Service Catalog items.
The drop-down list of suggested results shows up to five suggestions. Select the More link to view
additional suggestions. Select the Search button or press Enter to view all search results.

The Cards with Search style was introduced to the OOTB Service Catalog in CSM 9.2.0. If you upgraded
from a version of CSM after 9.2.0, you can implement the Cards with Search or Cards with Search v2
styling.

The number of columns adjust according to the size of the user's screen. When a user's screen size is
small enough that only one column of cards is displayed, the card icon will be hidden.

Figure 1. Cards with Search
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Figure 2. Cards with Search v2
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Related concepts
Supplied Service Catalog and Cards with Search Styling
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About Service Carts
CSM provides a service cart as a Major Business Object for customers to use in the supplied IT Portal.

A service cart is an e-commerce tool that allows customers to add multiple Service Requests to a single
order, and then temporarily hold the items until they are ready to submit the full order. When the order is
submitted, each Service Request automatically creates associated Tasks based on related Service
Catalog Template Work Units. Technicians fulfill the Service Requests in CSM, and customers view and
track the Service Requests (and Service Request history) on the My Service Orders page of the
Customer Portal.

Note: Service Cart can be used to support Multi-Sourcing Service Integration (MSI) and Service
Integration and Management (SIAM).

Related concepts
OOTB IT Portal Site
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About Portal Visualizations
Portal visualizations look and behave similarly to visualizations in the Browser Client.

A visualization is an interactive graphical representation of related data, represented as a relationship
chain with colored nodes (boxes) and links (arrows). Defined alerts can also be added to indicate potential
risk. Examples include:

• Configuration maps (records that are linked using a common factor)

• Organization charts

In the Portal, users can:

• View a visualization using the Visualization button on the menu bar.

Note: In order to open the visualization in the Portal, the visualization feature must be added
to one of the supplied Portal Site menu bars.

Good to know:

• Actions, dashboards, visualizations, calendars, widgets, and searches can be viewed, accessed, or
run in the CSM Portal; however, they are managed (created, edited, and deleted) and configured
(security rights and defaults) only in the CSM Desktop Client and CSM Administrator.

• The Portal Visualization window provides much of the same functionality as the Desktop
Visualization window and includes the toolbar, Main pane, Aerial pane, and Legend; however, the
Portal Visualization window does not include a menu bar.

Related concepts
The Relationship between CSM and SIAM
Related tasks
Define Menu Bar Properties for a Portal Site
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OOTB IT Portal Site
CSM comes with an OOTB IT Portal site, complete with Portal-specific forms and dashboards.

The site is built using OOTB site items and predefined properties (below). If you want to implement ITSM,
you can implement this site so that you can explore the features, and then modify it or create new sites to
meet the needs of your organization. OOTB site items include:

• Home Dashboard: Directs customers to log and/or view Incidents and Service Requests, find help
by browsing Knowledge Articles and FAQs, and manage their devices through Service Requests.
Also displays live metrics (global and personal) and a live announcement board.

Note: CSM also provides a not logged-in dashboard for anonymous customers. This
dashboard is simple and provides access to only a few self-service operations (example:
Resetting a password).

• Service Catalog: Displays all available services in a dynamic card format.

• Metrics: Displays detailed metrics for the customer (My Items), department (Department Items),
and records (Status and Problems). Metrics are displayed by using dashboards.

• Portal-specific Incident, Change Request, and Knowledge Article Forms: Simple forms help
customers log and manage their own records.

OOTB IT Portal Site properties include:

• General properties: Defines the name (IT) and associated document repository (Default Portal
Documents).

• Display properties: Defines the Startup Item to display when first accessed (a dashboard named
Portal (not logged in)) and the alternate Startup dashboard to display upon login (Portal Default).
Also defines the theme and search control.

• Banner properties: Defines the title and subtitle, as well as the colors.

• Footer properties: No footer is used.

• Menu bar properties: Defines which items to display on the menu bar (Home, Service Catalog, My
Devices, IT calendar, charts and items, and Service Orders).

◦ Reset Password is a conditional menu item that only displays when the Portal (not logged in)
dashboard is active.

◦ The BeyondTrust Chat Request menu item is also conditional and displays only when
BeyondTrust is enabled.

◦ Service Orders is conditional and only displays when the Service Cart Enabled Stored Value
is set to True. This value must be set for each language.

• Localization properties: Translated sites are available for Spanish, French, German, and Brazilian
Portuguese. You can override certain properties for each translated site.

Related concepts
Implement a Portal
Create a Custom Portal
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Navigate the CSM Portal Site Announcement Board
About the Service Catalog
Related tasks
Define Localization Properties for a Site
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CSM Portal Good to Know
Use these tips for helpful information on the CSM Portal.

• The CSM Portal is personal (you can display different views for different customers).

• The CSM Portal allows anonymous access (customer is not required to log in), though access to
data is limited.

• If a CSM Portal site requires a log in, customers must have CSM Portal login credentials, which
means they must have a customer record with defined credentials and security rights.

• Content can be real time or static and is organized using a set of highly configurable sites that you
create for your customers.

• A CSM Portal site can contain any number of site items, including Business Objects/records
(customers can create and edit records), Actions (including powerful create options and interactive
One-Step Actions), Action Catalogs, dashboard and widgets, document repositories, HTML pages,
reports, search groups, and searching.

• When a customer first accesses a site, a default Startup Item is displayed; this can be an Action
Catalog (special widget), dashboard, document repository, HTML page, report, or saved search
(used to display a list of records). A customer can access other site items using the Site menu bar.

• To help you get started, CSM provides a IT CSM Portal site. This site is built using supplied site
items (example: A Service Catalog, Portal-specific forms, service desk-specific dashboards, a
document repository) and predefined properties (Startup Item, alternate Startup Item, header/footer,
menu bar). Implement and use this IT CSM Portal site as provided, tailor it, or create new sites to
meet the needs of your organization. For more information, see Portal Site Design Ideas and Create
a Custom Portal.

• You may see random characters in a CSM Portal page's URL. These are related to query strings
and are normal behavior.

• Security rights control access to CSM functionality and are configured in the Security Group
Manager in CSM Administrator (Security > Edit Security Groups). For more information, see
Security rights and Configure Portal Security Rights.

Related concepts
Add Customers to the CSM Portal
Portal Sites
Site Items
Document Repositories
OOTB IT Portal Site
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Use a CSM Portal
Use the CSM Portal to access services provided by your company.

Portals are highly configurable, so each company typically has a unique CSM Portal. For assistance using
your CSM Portal, contact your CSM administrator or read the information in this section.

Related concepts
Define Display Properties for a Site
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Log in to a CSM Portal
The CSM Portal can be configured so customers and users do not need to log in, but functionality is
limited until a login is complete.

To log in to a CSM Portal:

1. Navigate to https://server/CherwellPortal, where server is the location where CSM Web Applications
are installed.
This opens the default site chosen by your administrator.

Tip: To navigate to a specific site, specify the site in the URL (example: https://server/
CherwellPortal/Marketing).

2. Depending on the design of the CSM Portal, you may need to select the Login link. Consider that
not all Portals and sites require login.

3. Provide your user name and password. If Windows/LDAP authentication is enabled, provide your
Windows credentials.

4. Select Login.
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Navigate to a Site
Navigate directly to a site or use the Site Selector.

If a CSM Portal contains multiple sites, site options display in the Site Selector, which is located on the
application bar. The list of sites varies depending on whether or not you are logged in, which sites your
system administrator has chosen to expose using the Site Selector, and your security rights.

You can also navigate to a site directly by name using the URL https://server/CherwellPortal/SiteName,
where server is the server where the CSM Web Applications are installed and SiteName is the name of
the site you want to visit. If you enter an invalid value or you omit the site name, you are taken to the
default site.

CSM 2022.3 Client Suite 137

CSM 2022.3 Client Suite



Log a CSM Portal Record
The CSM Portal allows you to easily log records using the Service Catalog.

The types of records you can log depend on your CSM Portal. Examples include:

• Incident: An Incident is an unplanned interruption to a Service or a reduction in the quality of a
Service (example: Something is not working).

• Request: A Service Request is a request for information, advice, a Standard Change, or access to a
Service (example: Installation of new software). The Request form may contain different fields
depending upon the type of service requested (example: New Device vs. Network Request).

In the supplied IT CSM Portal, Incidents and Service Requests (often called Requests) are stored
together in the Incident Business Object. The Categorization (Service/Category/Subcategory) identifies
the record as either an Incident or Request and is decided by the service chosen in the Service Catalog.
You can also log an Incident or Request using the Affects Me Too link on a Problem logged by another
customer or user.

Related concepts
Affects Me Too
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Log a CSM Portal Incident
In the supplied IT CSM Portal, log an Incident from either the Service Catalog or a Configuration Item
form. You can log a Service Request directly from the Service Catalog.

To log an Incident or Request from the Service Catalog:

1. In the Service Catalog, select a title that is appropriate for your request. For example, select IT
Service Desk.

2. Select a tile that is appropriate for your request, and then select a link to submit a record. For
example, select Report Outage or Error, and then select Submit Incident.

3. Complete the Incident form.

Note: To submit an Incident on behalf of another person, select the Submit on behalf of
another user check box.

4. Select Submit.

A window opens to notify you of the Incident ID number.

5. View the new Incident or Request from the My Items section.

Remember: When you use the Submit on behalf of feature, you are the requester and the person
you're submitting the Incident for is the Incident owner. The Incident owner is the only one who
can edit or add attachments to the Incident. Ensure requesters understand this restriction so they
can include all relevant information prior to submitting the Incident.

Related concepts
About Rich Text
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Affects Me Too
Affects Me Too functionality is a way to log an Incident or Request that links to a similar, pre-existing
Problem in the OOTB IT CSM Portal.

When the Affects Me Too link displays on a Problem, a new Incident or Request can be created with a
unique ID number simply by selecting the link.
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Approve a Request in the CSM Portal
Use the CSM Portal to approve requests, for example, for Incidents and Changes.

Important: Editing, responding to, or progressing, an approval in the Portal does not consume a
CSM license.

If your system has been configured as described in Configure Customers Approvals for the CSM Portal, a
customer can see approvals in the approvals widget on the My Items dashboard.

This applies to approvals created using an approval block or created manually. For more information on
manual approvals, see Configure Customer Approvals

A customer can then navigate through the workflow for that item and approve, deny, or abstain the
approval record.

Related concepts
About Approvals
About Delegation
Add an Approval to a Business Object
Approval Form
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Navigate the CSM Portal Site Announcement Board
The Portal Announcement Board provides a collaborative environment for customers to share information
in real time.

The announcement board can be customized using the Widget Manager.

On the Portal Announcement Board, users can view an announcement topic.

Related concepts
Managing Widgets
Related tasks
View an Announcement Topic

CSM 2022.3 Client Suite 142

CSM 2022.3 Client Suite

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=managing_widgets
https://help.cherwell.com/bundle/csm_client_suite_2022_3_help_only/page/content%2Fclient_suite%2F..%2F..%2Fcontent%2Fclient_suite%2Fview_a_discussion_topic.html


View an Announcement Topic
View an announcement topic in the supplied Portal Announcement Board.

To view an announcement on the announcement board:
On the home page, select an announcement link from the Support Announcements section.
The announcement topic opens.

You can:

• View the message (a more detailed explanation of the problem/concern/announcement).

• Read the responses from other customers and users.

• Add a comment.

• See who posted the announcement.

Related tasks
Add a Comment
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Add a Comment
Add a comment to an announcement topic in the supplied CSM Portal to share additional information.

To add a comment from the announcement topic page:

1. Open an existing announcement topic.
2. Select Add a Comment.

The Comment prompt opens.
3. Provide a comment.
4. Select OK.
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Navigate CSM Portal Knowledge Articles
Customers and users can access Knowledge Articles in the supplied Portal to help solve issues without
having to log Incidents.

Find Knowledge Articles in the CSM Portal:

• Using the Search Knowledge Articles control.

• Using the Knowledge Article dashboard. Open the dashboard by selecting Knowledge Articles on
the menu bar.

From a Knowledge Article, users can:

• Read article content.

• Allow users and other customers to know if an article resolved your issue:
◦ Select Yes if the article helped.

◦ Select No if the article did not help. The Incident is logged and a new window opens with the
Incident ID.

• Add a comment by selecting the Add Comment link.

View or hide comments using the vertical splitter bar.

• Vote on the Knowledge Article by selecting the Like this Article link to let other customers and
users know that the article was helpful or informative.

Related concepts
CSM Desktop Client Quick Search Widget
Resize Forms Using Splitters
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Create a Knowledge Article in the Portal
By default, only members of the Portal Workgroup Manager Security Group have the rights to create new
Knowledge Articles in the CSM Portal.

To create a new Knowledge Article in the Portal:

1. In the supplied IT Portal site, open the Knowledge Article dashboard by selecting Knowledge
Articles on the menu bar.

2. Select Create a Knowledge Article in the Search Knowledge Articles section.
3. Select an Article Type.
4. Provide a title and the article content.
5. Select Save.

Related concepts
About Security Groups
External Portal Sites
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View Knowledge Articles as Anonymous User
If enabled, anonymous users can view knowledge articles to help solve issues without having to log in to
the CSM Portal.

To view knowledge articles as an anonymous user in the OOTB Portal:

1. Open a browser and navigate to the CSM Portal home page, and then navigate to the Knowledge
Articles section.

2. In the Search field, type one or more keyword(s) related to a knowledge article you want to view
and select Enter.

3. In the search results, select the link to the knowledge article you want to view.

Note: Anonymous users can only view records. You must log in to interact with or edit
records in the Portal.
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Design a Portal
Useful tips and consideration when designing a Portal.

Portal design is important. Before creating a Portal:

• Answer questions about audience, scope, and purpose.

• Review Portal design tips.

• Consider how CSM features, such as Security and site items play into design.

• Optional: Start with the supplied IT Portal Site for design ideas.

Related concepts
Portal Design Worksheet
Portal Design Tips
Portal Design Considerations
Portal Site Design Ideas
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Portal Design Worksheet
Use the Portal design worksheet to assist you in creating a Portal.

Before creating a Portal, you should ask yourself some basic questions to help drive the design.

 Question Consideration

1. Who is your audience (in other words, who are your customers)?

a. Are your customers internal
employees? External? Both?

• Portal login credentials.

• Anonymous login/Security Groups.

b.

Are your customers
experienced? IT personnel who
can complete tasks by
themselves? Novice customers
who need guidance? Both?

• Number of sites (single site or one for each expertise level).

• Site item and navigation design (simple or sophisticated).

• Portal Views (personalize and secure what customers see).

• Automation (Add One-Step Actions/Actions to simplify
tasks).

 

Tip: Expose customers only to the information they
need.

c.

Do your customers have
different interests (different
teams/different responsibilities
(example: General Status for
Managers, Requesters of IT.)

d. Are your customers
international? • Localization.

2. What will your customers need to do in the Portal?

a.

Will your customers view/
monitor data (reports,
dashboards)? Interact with data
(Action Catalog/create Incident
or Service Request)? Both?

• Add data-driven site items (reports, dashboards, document
repositories) or action-driven site items (Actions to create/
edit records, run One-Step Actions, launch CSM
Managers).

• Security groups/Security rights (View, Create, Delete).

• Record ownership.

• License consumption.

b

What activities do your
customers need on a site
(example: run a report, create
an Incident, access documents
(doc repository)?

• Create site items that deliver what customers need most.

• Make information easy to find (Startup Item should be
informative).
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 Question Consideration

c. Will your customers need
searching capabilities?

• Display a search control.

• Display Saved searches to automate common searches.

• Add an Action to display the Search Manager (allows
custom Searches).

d. Will your customers need to
access documents? • Display a document repository.

e. Will your customers need to
access other websites? • Display an external HTML page or an external site.

3. Will your customers need access to data other than their own?

a.
Will your customers need to
view/edit other customers'
records?

• Record ownership.

• License consumption.

4. Will different customers need different security?

a. Will you allow customers to
access data without logging in?

• Anonymous login/Security Groups.

• Different Startup Items for logged-in/anonymous
customers.

b. Will you require a login? • Customers will need Portal login credentials.

c.
Will some customers need view-
only rights? Will some need edit
rights?

• Anonymous login/Security Groups.

Note: For more information about considerations
and some helpful design tips, see Portal design
considerations and Portal design tips. For more
information about Security (security groups,
license consumption, scope) refer to the Security
documentation. For more information about site
items (including how to create each), see their
respective documentation.

Related concepts
Add Customers to the CSM Portal
Anonymous Security Group
Site Items
Portal License Consumption
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Record Ownership
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Portal Design Tips
Use the Portal design tips for useful information and recommendations.

The following are some tips to help design a Portal that meets the needs of your Service Desk and your
customers for any department:

• Make it easy to find: Layout and navigation are important. Strategically place important information
or commonly-accessed services in obvious places. Use tables, bullets, columns, and headings to
elegantly organize information into logical and clearly-labeled groupings. Enhance navigation by
using an intuitive menu bar, Actions, and links.

• Make it easy to use: Keep it simple. Simplify forms and Service Catalogs so that customers are
only exposed to the information they need. Use customer-friendly language so that customers feel
comfortable with the content. Automate common tasks using One-Step Actions/Actions and
templates.

• Make it personal: The Portal is highly customizable so make each customer's experience relevant
and personal. Create custom dashboards and forms, expose only relevant services and Knowledge
Articles, dazzle customers with meaningful graphics, colors, and logos.

• Make it enticing: Do not underestimate the visual experience. Employ visual elements, such as
graphics, symbols, and colors, to convey information and embellish the aesthetic. Use consistent,
browser-friendly fonts and colors (or themes) to ensure stability and cohesion.

• Make the Startup Items count: Your Startup Items set the tone for your Portal and sites. Select an
OOTB Portal Site that effectively introduces your Portal. Designate a Site Startup Item that
immediately communicates the purpose of your site and provides clear access to common Actions.
For example, select an Action Catalog that clearly communicate your service offerings or a
dashboard that provides status, common Actions, and links.

• Proactively share: Post advisories and bulletins (known errors, outages, and solutions) to help
avoid potential issues. Set expectations by communicating your services and policies to avoid
confusion and misunderstandings.
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Portal Design Considerations
Use these tips when designing a Portal.

• Customer Security Groups: Users (Service Desk professionals working in CSM) and customers
(end-users using the CSM Portal to conduct self-service activities) perform different functions in
CSM and, therefore, require different security.

• Security rights: Security rights control access to CSM functionality and data. For example, to
create a dashboard, you must have security rights to access the Dashboard Manager (functionality).
To view, add, edit, or delete the Description field in an Incident record, you must have security rights
to access the Incident Business Object and the Description field (data). For more information, see
Security rights.

• Anonymous Access (allow customers to access Portal data without logging in): CSM
provides an Anonymous Security Group for customers who need to access the Portal without
logging in. The Portal Client uses this Anonymous Security Group to define security rights for those
anonymous customers.

• Portal Views: Use a Portal form view to create customer-specific versions of your forms. A Portal
view allows you to expose data to customers in a more secure and customer-friendly way.

• Record ownership: Access to records is controlled through record ownership. Typically, customers
own and can access their own records. However, record ownership rights can be extended to
managers, workgroups, and Workgroup managers so that customers can update records that are
owned by another customer.

• License consumption: Customers can view, create, and edit their own records without consuming
a license. With security rights, a customer can also view, and in some cases, edit (through a One-
Step Action) another customer's records without consuming a license. For more information, see
Portal license consumption.

• Site scope: CSM provides a site scope, which allows you to limit CSM Items (dashboards, reports,
One-Step Actions) to a specific Portal site.

• Startup Site Items: Each site has a designated Startup Item (example: a dashboard) which is
displayed by default when the site is first accessed. If desired, a different Startup Item can be
displayed upon login so that information can be more securely or appropriately filtered based on
credentials. For more information, see Site items.

• External Sites: The Portal can link to external websites using a simple link to a URL.

Related concepts
About Security
About Security Groups
Presenting Different Views to Users
Security Considerations
External Portal Sites
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Portal License Consumption
A customer can view, create, and edit their own records without consuming a license.

With security rights, a customer can also view, and in some cases, use a One-Step Action to edit another
customer's records without consuming a license.

CSM notifies the customer when a concurrent license is necessary. If the customer does not have rights
to consume a license, they are told that they cannot edit the record.

Note: A site can be configured to always use a license. (This might be done for a management-
focused site where it is assumed that all work is done against other customer's records).

Portal license consumption rules:

• A customer logging in to CSM through the Portal to view/edit their own records (they are the
customer record owner, meaning they are the requester/initiator and is associated with the record)
does not consume one of the concurrent licenses.

• A customer logging in to CSM through the Portal to access someone else's records (they are not the
requester but has been granted access rights) does not consume a license to view the record but
does consume a license to edit a record.

• A customer can run some One-Step Actions without consuming a license:
◦ One-Step Actions Actions that do not alter data can be run without consuming a license

(example: Send an email).

◦ One-Step Actions Actions that do alter data can be run against records owned by the
requester without consuming a license.

◦ One-Step Actions Actions that alter data generally consume a license when run against a
record owned by someone other than the requester. However, there are a handful of situations
where a One-Step Action is allowed to change another requester’s record without consuming
a license:

◦ Creating a journal entry: For example, allowing a customer to provide feedback on an
Incident or Knowledge Article even if they are not an owner/requester.

◦ Rating a record: Toggling a logical field or incrementing the count in a numeric field
(example: Allowing a customer to vote on whether or not they liked a Knowledge Article).
The field must be appropriately configured by the administrator to hold a rating value.

Related concepts
License Consumption
Application Security
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External Portal Sites
The Portal can link to external websites using a simple URL.

This helps make all of your customer-facing sites feel more integrated because CSM and non-CSM sites
show up next to each other. For example, incorporate your organization's website or a department's
website into the Portal, or add a website that supports your hardware.

Note: The way your CSM Portal is accessed (via HTTPS or HTTP) affects the display of an
embedded HTML page.

Related concepts
HTML Pages Good to Know
Related tasks
Create a Knowledge Article in the Portal
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Portal Site Design Ideas
CSM provides an OOTB IT Portal site to get you started.

The OOTB IT Portal site is built using OOTB site items (dashboards, forms) and predefined properties
(Startup item, header/footer, menu bar). You can use this Portal site as provided, or tailor it to meet the
needs of your organization.

Design ideas include:

• Edit the site display for logged-in and not logged-in modes.

• Edit the banner.

• Edit display options for the footer.

• Display your organization logo in the banner and/or footer.

• Display organization Business Hours.

Related concepts
OOTB IT Portal Site
Site Items
Edit a Site
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Implement a Portal
Use these steps to implement the supplied IT Portal site.

Complete the following steps to implement the supplied IT Portal site:

1. Review the Portal site. Understand the supplied site items (dashboards, the Service Catalog, the
discussion board, the document repository) and the supplied properties (header/footer, menu bar).

2. Configure required Portal settings:
a. Configure the Portal URL.

b. Set the default domain in CSM Administrator.

c. Create Portal login credentials for a customer. Typically, this is done as part of the security
setup.

Note: CSM provides other default settings (example: anonymous login, password
enforcement rules); you can change these, if needed, but it is not required.

3. (Optional) Explore ideas for Portal site design. For more information, see Portal site design ideas.

4. (Optional) See ideas for creating a custom Portal. For more information, see Create a custom
Portal.

Related concepts
OOTB IT Portal Site
About the Service Catalog
Define the Default Domain and Anonymous Login Settings
Configure Login, Authentication, and Inactivity Settings for the CSM Portal and CSM Browser Client
Related tasks
Configure CSM Web Application Settings (URLs, Timeouts, RSS Feeds)
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Create a Custom Portal
You can use these options or create a Portal from scratch.

We recommend starting with this design and then customizing it to your specific needs. However, users
can create a Portal from scratch, if needed.

To create a custom Portal:

1. Design the Portal (site items, navigation, security).

2. Create the site items to include on each site. Users can include the following:
◦ Business Objects and records. For more information, see Business Objects/records.

◦ Actions. For more information, see About Portal Actions.

◦ Action Catalogs. For more information, see About Portal Action Catalogs.

◦ Dashboards and Widgets. For more information, see About Portal dashboards and widgets.

◦ Document Repositories. For more information, see About document repositories.

◦ HTML Pages. For more information, see About HTML pages.

◦ Reports. For more information, see About reporting.

◦ Saved Searches. For more information, see About saved searches.

◦ Searching. For more information, see About searching (rich searching, combined searches
and results).

3. Run the Site Wizard to create one or more cursory sites: Create cursory layout and characteristics
for the site (title, Business Object associations, display, and document repository association).

4. Refine/edit sites using the Site Editor and Site Properties window: Refine the way the site/site
items look and behave. For more information, see Refine/edit a site.

5. Configure the Portal. For more information, see Configure a Portal (settings, login credentials,
password enforcement rules).

Related concepts
Portal Sites
Design a Portal
Portal Site Design Ideas
Steps to Implement the OOTB IT Portal
Related tasks
Create a Site Using the Site Wizard
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Build and Manage a Portal
Use the Site Manager and Site Wizard to help you build and manage a Portal.

Portals are highly configurable. When you create your Portal, you decide how many sites to create, which
site displays by default, how each site looks, which site items are displayed on each site, and who can
access each site/item.

To help create and manage your Portal, CSM provides the:

• Site Manager: Helps manage sites.

• Site Wizard: Walks through the steps to create a cursory site.

• Site Editor and Site Properties window: Help edit/refine the way site/site items look and behave.

• CSM Item Managers: Help manage site items, such as dashboards, HTML pages, and document
repositories.

Note: Good design is important. Before creating a Portal, see our recommendations on how
to design a Portal.

Related concepts
Site Manager
Design a Portal
Related tasks
Create a Site Using the Site Wizard
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Site Manager
Use the Site Manager to complete general CSM Item Manager operations for sites.

You can also mark a site as the default site for the Portal.

1. Menu bar:

Displays a row of drop-down menus available in the Manager.

2. Toolbar:

Displays a row of buttons for operations available in the Manager.

3. Search Control:

Displays a search box to find specific words or phrases in the Manager.

4. Manager tree:
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Displays items in a hierarchical tree, organized by scope, and subfolder if applicable. Also lists any
searches run during the session.

5. Main Pane:

Displays items by view (icon, list, or details [grid]) and lists search results when a search is run.

Related concepts
CSM Item Manager Main Window (Typical)
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Open the Site Manager
Open the Site Manager from CSM Administrator.

To open the Site Manager:

• In the Blueprint or mApp Editor menu bar, select Managers > Site Manager.
• In the CSM Administrator main window, select Browser and Mobile > Site Manager.

Related concepts
Blueprint Editor Menu Bar
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Create a Site
The Site Wizard helps you create a basic working Portal.

The Site Editor/Site Properties window helps you add refinement. You can skip refinement, if needed, or
you can select Finish at any time in the Wizard and go straight to refining.

To create a site:

1. Run the Site Wizard to create a cursory site: Create cursory layout and characteristics for your
site (title, Business Object associations, display, and document repository association).

2. Refine/edit your site using the Site Editor and Site Properties window: Refine the way your
site/site items look and behave.

a. Define general properties for the site: Define the name and title, login requirements, record
ownership, the Business Object/record associations (which Business Objects/records the
customers can interact with), and the document repository association.

b. Define display properties for the site: Define appearance (color/theme), Startup Site Items,
and search capabilities.

c. Define Banner properties for the site: Define what the site banner looks like (background
color and image, and banner image) and what text displays on it (title, subtitle, and baseline).

d. Define footer properties for the site: Define what the site footer looks like (background color
and image, and footer image) and what text displays on it (title, subtitle, and baseline).

e. Define menu properties for the site: Define which site items display on the site menu bar,
and which Actions a customer can initiate from each.

f. Define Localization properties for the site: Select a default language and override options
for translated sites.

Related concepts
Edit a Site
Site Items
About Portal Actions
Related tasks
Create a Site Using the Site Wizard
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Create a Site Using the Site Wizard
Use the Site Wizard to walk through the steps to create a site.

To create a site using the Site Wizard:

1. Open the Site Manager.
2. Select Create New, and then select Site.

Note: To create an external site, one that simply displays an existing website, select
External Site. The External Site window opens to provide the URL and other options.

3. Select Next.
4. Define basic properties for the site:

a. Specify a title for the site that displays in the banner.
The Name and Description fields initially include text that you can refine later. The Name
becomes part of the URL for referencing this site in a browser. The Description is shown in
the Site Selector when customers switch between sites.

b. Select a theme (set of fonts, colors, and options) to be used by different elements. Using a
theme simplifies the cohesive look. You can change the theme at any time, which
automatically updates the various elements.
If the theme is changed, refresh the browser to view the changes.

c. Select Banner image to launch the Image Manager, and then select an image to display on
the site banner. You can select an existing image or import a new image.

5. Select Next.
6. Select the Business Objects/records to include on the site:

Note: These are the Business Objects with which you want your customers to interact. For
example, if you want customers to be able to view or create Incident records, select the
Incident Business Object.

a. Select Add to include Business Objects/records on the site.

Tip: Use the up and down arrows   to order the Business Objects on the site
menu bar and to indicate the relative importance of a Business Object on the Site.
select Remove to remove a selected Business Object from the site.

b. Select the Add newly associated objects to site menu check box to automatically add the
associated Business Object to the site's menu bar.

Note: When you add a Business Object to the site's menu bar, CSM adds a Business Object
menu option and some supplied Business Object Actions. For example, if you add Incident
to the menu bar, CSM adds an Action to create a new Incident, as well as Actions to launch
some Incident searches (My Open, Closed, and Recent Incidents). You can use these
Actions, modify them, or create your own when you define the menu properties.
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7. Select Next.
8. Select the document repository to include on the site:

Tip: You can use multiple document repositories on a single site. Within the Site Editor, you
can add an Action to display another document repository on the site menu bar.

◦ Select Create new document repository named to create a new document repository for this
site. Then, name the document repository (or leave the auto-generated name).

◦ Select Associate an existing document repository to use an existing document repository
for the site. Select the Ellipsis to open the Document Repository Manager, and then select an
existing document repository or create a new document repository.

◦ Select Do not associate a document repository if you do not want to use a document
repository on the site.

9. Select Next.
10. Select a Startup Site Item from the following:

a. Select Dashboard to display a dashboard on startup. Select the Ellipsis to open the
Dashboard Manager, and then select an existing dashboard or create a new dashboard.

b. Select Page to display an HTML page on startup. Select the Ellipsis to open the HTML Page
Manager, and then select an existing HTML page (or create a new internal or external HTML
page).

Note: The way your CSM Browser Client is accessed (via HTTPS or HTTP) affects the
display of an embedded HTML page. For more information, see HTML pages good to
know.

c. Select Other to display an Action Catalog widget, a document repository, a report, or a saved
search on startup. Select the item's ellipsis to open the Action Manager, and then select an
existing item.

d. Select The site requires the user to log check box to require customers to log into the site. If
you do not require a login, you can specify a different Startup Item for when the customer does
log in.

Note: A license is consumed when a customer logs in.

11. Select Finish.

Related concepts
Open the Site Manager
External Portal Sites
About Portal Actions
Action Manager
Related tasks
Define Menu Bar Properties for a Portal Site
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Edit a Site
Edit a site to customize it based on your preferences.

Use the Site Editor/Site Properties window (both accessed from within the Site Manager) to edit a Portal
site and its site items.

Related concepts
Site Manager
Portal Sites
Site Items
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Define General Properties for a Site
Use the General Properties page to edit basic site features that may have initially been defined in the
Site Wizard. Edit and customize the site title, login requirements, document repository association, and
Business Object association.

To define general properties for a site:

1. Open a site in the Site Editor (CSM Administrator > Site Manager > Portal Site Name).
2. Select the General page.
3. Define general properties for the site:

a. Title: Provide a title to display in the Portal UI. The site title and banner title were initially
created in the Site Wizard, but can be edited here.

b. Description: Provide a description to display in the Portal UI.
4. Define access options for the site:

a. Show in Site Selectors: Select this check box to include the site name in the Site Selector
drop-down list. The Site Selector is located on the Site Application Bar in the Portal Main
Page.

b. Require login for access to site: Select this check box to require users to login to the site.
c. Acquire a license at login (so editing other users' records will not require a prompt):

Select this check box to acquire a license for the user upon login.
d. Acquire a license on edit (suppress prompt): Select this check box to acquire a license for

the user upon editing another user's record while suppressing the prompt to acquire the
license (example: A site intended for managers that are editing other user records).

5. Select Business Objects to associate with the site:
a. Select Add.
b. Select a Business Object from the list. Choose Business Objects for users to interact with

(example: If a user needs to view or create Incident records from the site, select the Incident
Business Object).

c. Repeat steps A and B for all desired Business Objects.
d. Add newly associated objects to site menu: Select the check box to automatically add

associated Business Objects to the site's menu bar.
6. Select a document repository to include on the site.

a. Select the Associate an Existing Document Repository check box.
b. Select the ellipsis. The Document Repository Manager opens.
c. Select an existing document repository or create a new document repository.
d. Select OK to close the Document Repository Manager.

7. Select Save to close the Site Editor.

Related concepts
Document Repositories
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Configure the CSM Portal Site to Allow Anonymous
Access

To allow anonymous access, the CSM Portal site must be configured so that it does not require login.

To configure the CSM Portal site to allow anonymous access:

1. In CSM Administrator, select Browser and Mobile > Site Manager
2. Right-click on the site designed as your CSM Portal and select Edit.
3. In the General tab, clear the Require login for access to site check box.
4. Select Save.

Related concepts
Anonymous Security Group
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Define Display Properties for a Site
Use the Display Properties page to specify startup site items, login options, search capabilities, browser
tab images, and custom documentation. The Display page can also be used to further refine the site's
appearance and Theme.

Define General Appearance Properties
To define appearance properties for a site:

1. In CSM Administrator, select Site Manager to open your CSM Portal site in the Site Editor.

2. Select Edit. The Site Properties page opens.

3. Select the Display page.

4. In the Appearance section, define the following:
a. From the Theme drop-down list, select a theme to define sets of colors, styles, and fonts for

the site.

b. From the Use Background drop-down list, select a color to define the site's background color.
For best results, use Form Theme as the background color.

c. Select the Show Site Selector on application bar check box to display the Site Selector
drop-down list on the Portal Application Bar.

d. From the Keep menu visible when scrolling drop-down list, choose to keep the site menu
bar visible or hidden to when user's scroll. You can also choose to keep the menu bar visible
for mobile devices only.

5. Select Save.

Define Browser Tab Properties
To add a custom image to your site's browser tab:

1. In CSM Administrator, select Site Manager to open your CSM Portal site in the Site Editor.

2. Select Edit. The Site Properties page opens.

3. Select the Display page.

4. Select the Use Favicon check box.

5. Select the ellipsis. The Image Manager opens.

6. Upload a new image or choose an existing image:
a. Select the New button to upload a new image (example: your company logo).

Note: Favicon images have a size limit of 512K. An error message appears if the
uploaded image is too large.

b. Select an existing image from the Image Manager. The name of the selected image populates
the Favicon field.

7. Select Save to close the Site Properties page.
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Define Site Startup and Login Options
Define items that appear on site startup, as well as items that appear after a user has logged in.

The options you set on the Display page apply to the site's default language. You can customize startup
and login actions for each site language.

To define startup options:

1. In CSM Administrator, select Site Manager to open your CSM Portal site in the Site Editor.

2. Select Edit. The Site Properties page opens.

3. Select the Display page.

4. In the Startup section, define the following:
a. Select the ellipsis to the right of the Show on startup to select a Site Item to display when a

user initially accesses the site. Site items include widgets, dashboards, reports, HTML pages,
or saved searches.

b. Select the Show on login check box to display a different site item when users log in. Then,
select the ellipsis to select a site item.

c. From the View drop-down list, select the view to control the behavior and appearance of
Business Objects within the site. Options include:

◦ Role-based: Based on the default role associated with the user's security group.
Different users see different Business Object Forms based on security.

◦ Portal Default: Provides the default Portal view for Business Objects within the site.

◦ Portal Secondary: A view option for smaller, secondary sites that may supplement or
support your main site.

◦ Default: The default site view is not recommended because it also displays technician
forms, which are not relevant for site users.

5. Select Save.

Define Login Options
Customize what users see on when they log in to the Portal site.

To define login options:

1. In CSM Administrator, select Site Manager to open your CSM Portal site in the Site Editor.

2. Select Edit. The Site Properties page opens.

3. Select the Display page.

4. Select the Login Options button.

5. In the Text to display on login dialog box, provide a custom message for users when they log in to
the site.

6. Select the Show privacy link in login dialog check box to display a link to a privacy statement,
then provide text for the link and the URL to the privacy document.
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7. Select the Custom avatar image button to open the Image Manager, then select default images to
display for a non-logged-in customer and a customer without an assigned avatar.

8. Select the Redirect User on Logout check box to automatically redirect customers to a specified
URL when they log out of the Portal. Then, provide the URL or select the Browse button and select
a website where customers will be redirected after logging out of the Portal.

9. Select Save.

Define Search Control Options
The options you set on the Display page apply to the site's default language. You can customize the
search control for each site language.

To customize search control options:

1. In CSM Administrator, select Site Manager to open your CSM Portal site in the Site Editor.

2. Select Edit. The Site Properties page opens.

3. Select the Display page.

4. In the Search area, select one of the following options:
a. Use default: Select this option to use the search control options that are based on the list of

Associated Business Objects from the General page.

b. Use search widget: Select this option to use a custom search widget. Select the ellipsis to
open the Widget Manager, and then select a widget.

c. No search: Select this option to omit searching from this site by removing the search control.
You can still create search widgets and place them on dashboards to allow for target
searching.

5. Select the Require login before showing search results (excluding dashboards) check box to
require a user to login before performing a search. If a search is performed without requiring the
user to login, the search results are based on security rights of the Anonymous Security Group.

6. Select Save.

Disable or Enable Custom Portal Documentation
By default, the CSM Portal links users to the default Cherwell online documentation system. Due to the
highly configurable nature of the CSM Portal, a customer may choose to disable this feature or link to a
custom online documentation system.

To disable default CSM Portal documentation:

1. In CSM Administrator, select Site Manager to open your CSM Portal site in the Site Editor.

2. Select Edit. The Site Properties page opens.

3. Select the Display page.

4. Clear the Show help button check box to remove the default help button from the CSM Portal.

5. Select Save.
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To enable custom CSM Portal documentation:

1. In CSM Administrator, select Site Manager to open your CSM Portal site in the Site Editor.

2. Select Edit. The Site Properties page opens.

3. Select the Display page.

4. Select the Use custom URL option.

5. Provide an alternate URL in the Help URL field (example: a link to an internal documentation
system or training documents). This URL replaces the default Cherwell online documentation
system URL.

Important: The URL must be a full URL (example: https://www.sample.com) and not a
partial URL (example: sample.com).

6. Select Save.

Related concepts
Anonymous Security Group
Related tasks
Define Localization Properties for a Site

CSM 2022.3 Client Suite 172

CSM 2022.3 Client Suite

https://help.cherwell.com/csh?product=version-csm-2022.3&topicname=anonymous_security_group
https://help.cherwell.com/bundle/csm_client_suite_2022_3_help_only/page/content%2Fclient_suite%2F..%2F..%2Fcontent%2Fclient_suite%2Fdefine_localization_properties_for_a_site.html


Define Banner Properties for a Site
Use the Banner Properties page to edit the site banner. Some aspects of the banner may have initially
been defined in the Site Wizard. Edit and customize the banner size, color, fonts, and associated images.

To define banner properties for a site:

1. In CSM Administrator, open a site in the Site Editor (Site Manager > Portal Site Name.
2. Select the Banner page.
3. Select the Show Header check box to display a banner at the top of the site.
4. Define a banner background by doing one of the following:

◦ Select the Color Selector button to select a background banner color.
◦ Select Image to select an image to use as the banner background.

5. Define a banner image (example: your company's logo):
a. Select Browse. The Image Manager opens.
b. Select an image.
c. Select OK.
d. Provide pixel dimensions for the image in the Size field.
e. Select the Align drop-down list to edit the alignment of the image within the site banner.

Note: For best results, use an image size of approximately 134x40 pixels along with a
background color that will adjust the size of the banner based on the size of the browser
window. In addition, the image file size should not exceed 300 KB.

6. Provide a title for the site in the Title field.
7. Select Image Selector the Title area to change the color of the title.
8. Provide a subtitle for the site in the Subtitle field.
9. Select the Image Selector in the Subtitle area to change the color of the subtitle.

10. (Optional): Provide any additional text for the site banner in the Baseline Text field (example:
copyright notices).

11. Define a hamburger menu image (example: your company's logo):
a. Select Browse. The Image Manager opens.
b. Select an image.
c. Select OK. The selected image appears in the hamburger menu image preview field.

Note: CSM automatically scales images to a height of 25 pixels. The hamburger menu
bar replaces the Portal menu bar on mobile screens and browser windows sized below
768 pixels.

12. (Optional): Select the Fixed Height check box to make the banner a fixed, specified height. If
cleared, the banner resizes to accommodate selected text, images, and margins.

13. (Optional): Select the Extend Banner fo Application Bar check box to automatically resize the
banner based on the Site's Application Bar.
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14. Select the Margins button to define top, bottom, right, and left margins around site text.
15. Select Save.
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Define Footer Properties for a Site
Use the Footer Properties page to define background color, images, text, font, and footer size.

The site footer is located at the bottom of the site, and can provide additional general information (such as
a copyright notice) or aesthetic value. Use the site's Footer Properties page to define:

• What the footer looks like (background color and image, and footer image).

• What and how text displays on the footer (title, subtitle, and baseline text, fonts, and colors).

• The footer's height and position (relative to a margin).

To define footer properties for a site:

1. Open a site in the Site Editor (CSM Administrator > Site Manager > Portal Site Name).
2. Select the Footer page.
3. Select the Show Footer check box to display a footer at the bottom of the site.
4. Define a footer background by doing one of the following:

◦ Select the Color Selector to select a background banner color.
◦ Select Image to select an image to use as the banner background.

5. Define a footer image (example: your company's logo):
a. Select Browse. The Image Manager opens.
b. Select an image.
c. Select OK.
d. Provide pixel dimensions for the image in the Size field.
e. Select the Align drop-down list to edit the alignment of the image within the site banner.

6. Provide a title for the site footer in the Title field.
7. Select Image Selector in the Title area to change the color of the title.
8. Provide a subtitle for the site in the Subtitle field.
9. Select Image Selector in the Subtitle area to change the color of the subtitle.

10. (Optional): Provide any additional text for the site footer in the Baseline Text field (example:
copyright notices).

11. (Optional): Select the Fixed Height check box to make the footer a fixed, specified height. If
cleared, the footer resizes to accommodate selected text, images, and margins.

12. Select the Margins button to define top, bottom, right, and left margins around site text.
13. Select Save.
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Define Menu Bar Properties for a Portal Site
Use the Site Menu Properties page to define menu items, Actions, tooltips, expressions, and security
options for the site menu bar.

The site menu bar is located below the banner and lists the site items, as well as any Actions that support
the items. Use a site's Menu Properties page to define:

• Which site items display as menu items on the site menu bar.

• Which Action the menu item initiates: Display a dashboard, Service Catalog, or document
repository; run a report, display a record.

• The help text that displays on the menu item's tooltip.

• Expressions for showing/hiding and enabling/disabling menu items.

• Security options for showing/hiding and enabling/disabling menu items: For example, Always show,
show only for Anonymous (not logged-in Customers), or show only for Logged-in Customers.

• Display options (separators) for groups of menu items.

Related concepts
Define Business Object Actions
Refine/Edit a Site Reference
About Actions
Add Customers to the CSM PortalAdd Menu Items to Site Menu Bar

To add menu items and define menu item properties:

1. Open a site in the Site Editor (CSM Administrator > Site Manager > Portal Site Name).
2. Select the Menu page.
3. Select the Show Menu check box to add a menu bar to the site.
4. Select Add Action.
5. Select an Action to add to the menu bar.
6. Define general properties for selected Action:

a. Action name: Cannot be changed, displays the name of the selected Action.
b. Display text: Specify the text to display in the menu bar.
c. Select Image Manager.
d. Select an existing image or import a new image to represent the Action in the menu bar

(example: a house icon for home).
e. Help text: Specify a tool tip to display when the cursor is on the menu item.

7. (Optional): Define an expression to display in the menu bar:
a. Select the Visible check box. An expression can still be imported if this check box is cleared. If

so, the expression still runs in the background and is not visible in the menu bar.
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b. Select the ellipsis to import an existing expression or select the Custom Expression button
to create a new expression. Imported expressions populate the Visible Expression drop-
down list.

8. (Optional): Define an expression to enable or disable an item in the menu bar:
a. Select the Enabled check box.
b. Select the ellipsis to import an existing expression or select the Custom Expression button

to create a new expression. Imported expressions populate the Visible Expression drop-
down list.

9. Select security options from the drop-down lists to define rights for displaying, enabling, or disabling
the menu item:

◦ Visible: Select whether menu items are visible for all Portal customers (Always), only logged-
In Portal customers (Logged-in Only), or only Portal customers who are not logged in
(Anonymous Only).

◦ Select whether menu items are enabled for all Portal customers (Always), only logged-In
Portal customers (Logged-in Only), or only Portal customers who are not logged in
(Anonymous Only).

◦ Rights: Assign Portal rights to make menu items visible/enabled for a customer security
group.

10. (Optional): Select the Begin Group check box to display a horizontal line before menu items on
sub-menus to separate the sub-menu from other items.

11. Select the Show toolbars check box to show/hide toolbars on Business Object forms within the
Portal site.

12. Repeat Steps 4-10 for all desired menu items. Selected menu items populate the left-hand Action
pane.

13. Select Save.
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Define Localization Properties for a Site
Use the Localization page to select the default language for a site and to override the startup action,
login action, and custom Search Widget for each site translation.

To define Localization properties for a site:

1. Select Site Manager (CSM Administrator > Site Manager).
The Site Editor dialog opens.

2. Navigate to the folder containing the site in the Sites tree to display it in the right-hand pane.
3. Select the site in the right-hand pane and then select the Edit icon (pencil) in the toolbar;

alternatively you can right-click the site and select Edit.
The Site Properties page opens.

4. Select the Localization page.
5. From the Default Language drop-down list, select the default language to display in the Language

Selector on the Site Application Bar.
6. Select the Show language selector on application bar check box to show the Language

Selector for the site; clear the check box to hide the Language Selector.
7. Select Save.

Related concepts
Define Display Properties for a Site
Translating Strings for Portal Sites
Using Language Packs to Translate Portal StringsOverride Site Options for Each Language

By default, each site uses the startup action, login action, and custom Search Widget defined on the
Display Properties page. You can override these options for each language.

To override site options for a language:

1. Select Site Manager (CSM Administrator > Site Manager).
The Site Editor dialog opens.

2. Navigate to the folder containing the site in the Sites tree to display it in the right-hand pane.
3. Select the site in the right-hand pane and then select the Edit icon (pencil) in the toolbar;

alternatively you can right-click the site and select Edit.
The Site Properties page opens.

4. Select the Localization page.
5. Select the language you want to override, and then select Edit.
6. From the View drop-down list, select a custom view that you may have defined for the language, or

use Role-based to determine the view based on the user's role.
7. Select the Custom Startup Action check box, and then select the startup action for the translated

site. For example, if you have a translated dashboard or HTML page, you can select that.
8. Select the Custom login action check box, and then select the login action for the translated site.
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9. Select the Login options button to override login options for the translated site. For example, you
can set alternative text or a privacy link on the login window.

10. Select OK.
11. Select Save.
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Refine/Edit a Site Reference
Additional details for refining and editing a site.

Available Menu Bar Actions
The following are Actions that can be added to the menu bar:

• One-Step™ Action: Runs a One-Step Action. You can choose to run an existing One-Step Action
or create a new One-Step Action.

• Command: Runs a system command applicable to the Portal. Categories include:
◦ Managers: Adds a command to launch an Item Manager so a customer can choose an item to

open/run (example: Add the Report Manager to the site menu bar so customers can choose to
run an available report).

◦ Recent Items: Provides a recent Items list that displays the last five (5) items of the specified
type selected by the customer (example: the last five reports run by the customer). This makes
sense if you made the Manager available.

Note: Recent Items lists must be placed inside folders (they cannot be at the top level
of the site menu bar), and it is recommend that they be placed as the last item in the
folder.

◦ Chat: Includes commands related to remote support services (example: BeyondTrust) (only
available if you have Chat and Remote Support Connector Settings enabled in CSM
Administrator).

◦ (Other) Business Object Search: Provides common site searches (example: Business
Object to search, how the results should be sorted, whether to limit to the current customer,
and limit to open or closed records).

◦ (Other) Create Business Object: Creates a new Business Object (record) but with several
powerful options, such as a One-Step Action to run as part of the creation process and
whether a custom form should be displayed (which can be different than the default form used
for viewing a Business Object).

◦ (Other) Go to Edit Mode: Puts a Business Object record into edit mode so that a customer or
user can immediately edit it. This command is designed to be used in an Execute Command
One-Step Action, which is the automated equivalent of a customer or user selecting the Edit
button in the Portal.

◦ (Other) Home: Takes the customer to the Startup Item (example: dashboard, HTML page).

◦ (Other) New Bus Ob Drop-down list: Automatic command that displays a default list of
create commands for all Associated Business Objects for the site.

Note: This command must be placed in a folder.

• Dashboard: Displays a dashboard. You can display an existing dashboard or create a new
dashboard.

• Report: Runs a report. You can run an existing report or create a new report.

CSM 2022.3 Client Suite 180

CSM 2022.3 Client Suite



• Search: Runs a saved search. You can run an existing saved search or create a new saved search.

• Page: Displays an HTML page. You can display an existing HTML page or create a new HTML
page.

• Document Repository: You can display an existing document repository or create a new document
repository.

• Action Catalog: Displays an Action Catalog. You can display an existing Action Catalog or create a
new Action Catalog.

• Folder: Adds a folder to the toolbar so that you can organize Actions into another level.

Note: Some Actions also allow you to limit scope and Associated Business Object (select
the activated Options button). We recommend that you limit customers to just the site scope
and make items available in just that scope.

Available Site Items
Available site items that can be selected for a Portal site include:

• Action Catalog, (special widget), a dashboard, a document repository, an HTML page, a report, or a
saved search (used to display a list of records). For more information, see Site items.

Related concepts
About CSM Item Managers
Configure CSM Remote Support Settings
Define General Settings
Create/Edit a Dashboard
Create a Document Repository
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Select a Startup Portal Site
If you have more than one site on your Portal, you can choose a site to first display if the customer goes
to the main URL: http://MyServer/CherwellPortal.

Customers can also go directly to a particular Portal site by specifying it as part of the URL:

http://MyServer/CherwellPortal/IT

To select a startup Portal site:

1. Open the Site Manager.
2. Right-click Site > Set as Default.
3. Select Close.

Related concepts
Site Manager
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Troubleshoot a Portal Site
Troubleshooting solutions for Portal issues.

Use the following table to troubleshoot Portal issues.

Problem Solution

Cannot access tools to create
a Portal or site

Check your functionality rights (CSM Administrator > Security >
Edit security groups > User Security Group > Rights tab).

Customer cannot access a
Portal or site

Check the customer's functionality rights (CSM Administrator >
Security > Edit security groups > Customer Security Group >
Rights tab).

Customer cannot access data
on a Portal or site

Check the Customer Security Group's data rights(CSM Administrator
> Security > Edit security groups > Customer Security Group >
Business Objects tab).

Portal does not display correct
form

Verify the forms were designed in the Portal View, not in the Default
View.

Query does not work
Verify the query is set up correctly (not limited to a particular group).
Check security; records might not show up if the customer does not
have appropriate rights.

Automatic Actions not working Verify automatic Actions are run from the Portal view, not the Default
View.

Customer can edit another
customer's record Change the record ownership rights.

Windows Account not
registered message Create login credentials for the customer.
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Configure a Portal
Configure the portal so customers can log Incidents.

Note: The majority of the configuration is conducted using the Browser and Mobile Settings
page in CSM Administrator.

Required steps include:

• Configure portal security rights.

• Configure client application settings (URL and timeout).

• (Optional) Specify a default domain for the portal.

• (Optional) Configure login, authentication, and inactivity settings for the portal (only if you want them
to be different from the Desktop Client).

• Configure anonymous login settings.

• Configure Cherwell credential settings (user/customer password rules).

• Configure miscellaneous browser/portal settings.

• Create portal login credentials for a customer.

• (Optional) Configure customer approvals in the portal.

Related concepts
Configure the Browser Client
Configure Portal Security Rights
Configure Cherwell Credential Settings (User/Customer Password Rules)
Add Customers to the CSM Portal
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Configure Portal Security Rights
Configure Portal Security Rights before customers can access the Portal.

Because Portal access must be set differently for anonymous browsers as well as logged-in customers,
there are several places that Portal security rights must be set in CSM Administrator before users and
customers can access the Portal. The following are all the rights that must be configured for anonymous
browser and Portal customers:

• Application rights

• Browser and mobile device rights

• Calendar rights

• Chat Service Integration rights (BeyondTrust)

• Command Manager rights

• Dashboard rights

• Document repository rights

• HTML page rights

• Knowledge rights

• Record locking rights

• One-Step™ Action rights

• Report rights

• Searches rights

• Security features rights

• Sites rights

• Sites Manager rights

• Users' rights

• Visualization rights

• Web Service One-Step Action rights

Related concepts
Security Rights Reference
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Configure Customers Approvals for the CSM Portal
Some configuration needs to be done before customers can action approvals in the CSM Portal.

Prerequisites:

Important: Only customers who upgrade to CSM 10.2.0 and later from an earlier version of CSM
need to follow these steps. Those who install new installations of CSM already have these
changes in the supplied demo content.

Create an approver workgroup

Configure manual customer approvals

Related concepts
Create a Search Results List Widget
Open the Dashboard Editor
About Approvals
About Delegation
Configuring Approvals
Related tasks
Configure Customer Approvals
Create an Approver WorkgroupConfigure the Approval Business Object

1. Open CSM Administrator and select Create a New Blueprint.
2. Select the Approval Business Object.
3. Select Edit Business Object.
4. Select Bus Ob Properties.
5. On the General tab, select the Show in Search Manager check box so queries can be created for

approvals using the portal.
6. Select OK to save the changes.

Make Approvals Visible in the CSM Portal

You can make approvals visible in the portal by using a widget.

Tip: You can also setup your system so that customers can access approvals using links in the
emails they receive when an approval has been created. An administrator can set up a link in the
email to open the approval record directly, using Go To Record links. See Linking Directly to CSM
Objects.

1. Create a Search Results List widget.
2. During creation, select Show results as links in the Display section.
3. For the custom query, select Approval.Approver ID Equals CurrentUserRecordID().
4. Select Save.
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5. To add the new Search Results List widget to the My Items dashboard for the portal:
a. Select Charts > My Items in the portal.
b. Open the Dashboard Editor.
c. Drag the widget from the Widget pane onto the My Items dashboard.
d. Make any remaining changes and then select Save.

Configure CSM Portal Customer Security Group

1. Open CSM Administrator and select Edit Security Groups.
2. Select Portal Customer from the Group drop-down list.
3. Select the Business Objects tab and then select Approval from the Business Object drop-down

list.
4. Ensure that both View and Edit check boxes are selected.
5. Select New Field in the Approval Business Object and again, ensure that both View and Edit check

boxes are selected.
6. Select X and then Yes to save your changes.
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Track Portal Use With Google Analytics
You can use Google Analytics to track user selections, such as mouse clicks and taps, in the CSM Portal.

For example, you can track:

• User logins

• Portal site usage

• Dashboard usage

• Service Catalog, including categories and services, usage

• Searches (from the toolbar Quick Search only)

• Action link clicks from the home page

User information, search criteria, and other data entered by users is not tracked.

Configuring Google Analytics for the CSM Portal
Prerequisites:

• You must have a Google Analytics account and access to the tracking ID for that account. For
details, visit the Google Analytics site.

Note: CSM supports tracking numbers in both the legacy format: UA-XXXXXX-X and the
latest Google Analytics v4 format of: G-XXXXXXX.

• A basic understanding of Google Analytics and how it tracks and reports site usage will help you
analyze CSM tracking data. Free training videos are available from Google.

To configure Google Analytics for CSM:

1. In the CSM Administrator main window, select the Settings category, and then select the Edit
System Settings task.

2. Select the Advanced page.

3. Select the Google Analytics Tracking ID (Portal) check box, and then add your tracking ID to the
box.

Important: Be sure to enter your tracking ID exactly as it is provided by Google Analytics.

4. Select OK.

Related concepts
Tips for Using Google Analytics with CSM
Configure Global Advanced Settings
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Tips for Using Google Analytics with CSM
Use these tips for using Google Analytics with CSM.

Google Analytics is a powerful tool for tracking, reporting, and analyzing data from web sites. This topic
provides a few tips for using Google Analytics with CSM. For detailed guidance, refer to the Google
Analytics documentation.

Use Views to Segregate Site Data
Depending on your reporting needs, you may choose to create views in Google Analytics for each Portal
site. This enables you to easily see tracking information specific to each Portal site.

For example, you can create a view to track data for the Portal IT site. You can see page views for all
pages for that site for a specific time period or you can filter the list of pages to specific areas, such as the
Service Catalog.

Tracking User Interactions
Events differ from page views because they provide data on how users interact with your Portal. For
example, you can use events to learn which Business Objects that users are selecting when they search
for records from the toolbar Quick Search.
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CSM Events include:

• Logins

• Menu selections

• Searches

• Action Links

Events are located in the Behavior area of Google Analytics.

Related concepts
Track Portal Use With Google Analytics
Configure Global Advanced Settings
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Supplied Service Catalog and Cards with Search
Styling

The Cards with Search style offers a modern, easy-to-navigate styling for Action Catalog items.

The Cards with Search style was introduced to the shipped Service Catalog in CSM 9.2.0.

Implementing Cards with Search
If you upgraded from an earlier version of CSM, you can implement the Cards with Search theme two
ways:

• Edit the existing Service Catalog widget

• Create a new widget to act as your Service Catalog

Using Images in Cards with Search
Cards with Search styling supports custom images at the root level, but not the action level. Use the
Groups page of the Widget dialog to link to a custom image.

To display images with root-level services in the Cards with Search view:

1. In the Groups page of the Service Catalog widget, select Display Options for the top-level group.

2. Select the Show image next to each item check box.
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3. Select the Field with Image option, then select Linked Image from the drop-down menu.
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Related concepts
About the Service Catalog
Example: Enable Anonymous View of Service Catalog
Related tasks
Implement the Supplied Service Catalog (Use an Existing Service Catalog Widget)
Implement the Supplied Service Catalog (Create a New Service Catalog Widget)
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Implement the Supplied Service Catalog (Use an
Existing Service Catalog Widget)

Use the Widget Manager to implement the supplied Service Catalog.

To update an existing Service Catalog to use the Cards with Search style introduced in the CSM
9.2.0 supplied Service Catalog:

1. From the Widget Manager, right-click Service Catalog, and then select Edit.
2. Select the Display page, and then select Cards with Search or Cards with Search v2 from the

Style drop-down list.
3. If necessary, add a description field in each lookup table, then add the field to the associated form.
4. Select the Show Image next to each command check box.

a. Select Field with Image to select a source for the image. The fields available in the drop-
down list are related to the Action Business Object selected on the Actions page.

b. Select Expression to build an expression to provide an image.

Note: To use card images on a single-level Service Catalog, ensure the Action Business Object
you choose has a field that stores images.
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Implement the Supplied Service Catalog (Create a
New Service Catalog Widget)

Create a new widget to implement the supplied Service Catalog.

To create a new Service Catalog using the Cards with Search style introduced in the CSM 9.2.0
supplied Service Catalog:

Create a New Service Catalog Widget:

1. In CSM Administrator, create a new Blueprint.
2. Open the Widget Manager and create a new Action Catalog widget.
3. Select the Display page, and then select Cards with Search or Cards with Search v2 from the

Style drop-down menu.
The image on each parent-level card shows either custom images or pre-CSM 9.2.0 supplied
images.

4. Select the Groups page, and then select Display Options for the top-level group.
5. Select the Show image next to each item check box.
6. Select the Field with Image option, and then select Linked Image from the drop-down menu.
7. Finish any necessary fields to complete the Service Catalog widget.

Map Description Fields

8. Important: The Incident Category and Incident Subcategory lookup tables also need a8.
description field to take advantage of the Cards with Search style. The title and description
text in each parent-level card are mapped to the description fields in the Service Major
Business Object. The child-level cards are mapped to description fields in the Incident
Category and Incident Subcategory Lookup tables.
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If your database does not have a description field in those Lookup tables, follow these steps:
a. Add description fields to the Incident Category and Incident Subcategory Lookup tables.
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b. Add the description field to the associated forms.

Add the New Widget to the Portal Menu:
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9. Open the Site Manager.
10. Right-click the portal site you want to add the new Service Catalog widget to and select Edit.

a. Select the Menu page, and then select the Add action down arrow.
b. Select Add Action Catalog action.

The Widget Manager opens.
11. Select the new widget.
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Enable Anonymous View of the Service Catalog
The CSM Portal can be configured to allow anonymous users to view the Service Catalog without having
to log in.

Note: Anonymous access requires some initial configuration. See Anonymous security group for
specific information.

Enable Anonymous view of the Service Catalog Business Object and then determine the way(s) in which
you prefer to enable the Service Catalog for Anonymous view on the CSM Portal, including configuring
the Service Catalog to show on startup, as a menu item enabled for anonymous access, or as an Action
Catalog widget enabled for anonymous access.Enable Anonymous View of the Service Catalog Business Object

1. In CSM Administrator, select Security > Edit security groups.
2. In the Group drop-down list, select the Anonymous Security Group (Default name: Anonymous

Browser).
3. Select the Business Objects tab.
4. In the Business Object drop-down list, select the Service Catalog Business Object (Default

name: Service).
5. Select the View check box for the Business Object and all associated fields. You must also grant

View permissions to any additional Business Objects associated with the selected Business Object
(example: Incident Category, Incident SubCategory).

6. Select Save.
7. Enable Anonymous View of any additional Business Objects associated with the Service Catalog

that should be visible to anonymous users.
8. Configure at least one of the following views for anonymous users.

Configure the Service Catalog to Show on Startup

1. In CSM Administrator, select Browser and Mobile > Site Manager.
2. Right-click on the site designed as your CSM Portal and select Edit.
3. Select the Display tab.
4. In the Show on startup field, browse for and select Service Catalog.
5. Select OK.
6. Select Save.

Enable Anonymous View of an Action Catalog Widget

An Action Catalog widget can be used to build a dynamic Service Catalog that is organized by Category
and Service, and is capable of executing Actions. Anonymous users can be enabled to view the Service
Catalog through this widget when they select a link to the Action Catalog from a dashboard, menu link, or
button.
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1. Open the Widget Manager.
2. Create an Action Catalog widget or modify an existing Action Catalog widget (Shipped Example:

Service Catalog) by right-clicking on the existing widget and selecting Edit.
3. In the General tab, follow the steps to define the General Properties for the Action Catalog widget.

Select theAllow Anonymous Access to Action Catalog in the Portal check box. When selected,
the Action Catalog is viewable to anonymous users.

Note: When this check box is cleared, the Action Catalog is not viewable to anonymous
users even if the associated Business Object(s) are configured to allow anonymous access.

4. Add a link to the Action Catalog from a dashboard, menu link, or button.

Configure the Service Catalog as a Menu Item with Anonymous Access

1. Enable Anonymous View of an Action Catalog widget (see above).
2. Follow the steps to add menu items to a site menu bar.

a. If the Action Catalog action already exists in the menu (Default: Service Catalog), select it to
view the menu properties. If the Action Catalog action does not already exist in the menu, in
the Add Action drop-down list, select Add Action Catalog action and select the specific
Action Catalog (Default name: Service Catalog).

b. In the Security Options section, select the Visible drop-down list and select Always or
Anonymous only.
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Configuration Management Page
Use the Browser and Mobile Settings page to access many of the CSM Portal and Browser Client
management and configuration tasks.

Browser and Mobile Settings can be found in CSM Administrator > Browser and Mobile.

Configuration tasks include:

• Site Manager: Use to manage Portal sites.

• Browser Application Settings: Use to configure URLs and session timeouts.

• HTML Page Manager: Use to manage HTML pages.

• Document Repository Manager: Use to manage document repositories.

• Twitter Account Manager: Use to manage Twitter accounts.

• Web Services Manager: Use to configure web services used for One-Step™ Actions.

• Edit Mobile Configuration: Use to set defaults (dashboards, Business Objects, and Actions) for the
entire system or for each role for Cherwell Mobile™.

• Open Mobile Dashboard Editor: Use to manage Mobile dashboards specifically designed for use
on mobile devices.
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Add a Portal Login Command to a CSM Portal
Dashboard, Menu, or Form

Use the Portal Login command as the action for a button or link on a CSM Portal dashboard or form. The
Portal Login command can also be added as an action in a CSM Portal menu.

When the button, link, or menu item is selected in the CSM Portal, the user is prompted with a Login
dialog.

Note: The Portal Login command is not supported in the CSM Desktop Client, CSM Browser
Client, or One-Step Actions.Add a Portal Login Command to a Dashboard

1. Open CSM Administrator and select Create a New Blueprint.
2. In the Managers menu, select Dashboards > Dashboard Manager.
3. Select the Portal dashboard you wish to edit and select Edit.
4. In the left pane, select and drag a Button or Link onto the dashboard.
5. Right-click the Button or Link Label and select Widget properties > Widget properties.
6. Select the ellipsis to the right of the Action field.
7. In the left pane, select Commands.
8. In the middle pane, select System > Other.
9. In the right pane, select Portal Login.

10. Select OK and then OK again.
11. Make any additional changes to the control (example: change displayed text from "Button" to

"Login").
12. Save the changes.

Add a Portal Login Command to a Menu

1. Open CSM Administrator and select Site Manager.
2. Right-click IT and select Edit.
3. In the left pane, select Menu.
4. In the middle pane, select Add Action > Add Command Action.
5. In the left pane, select System > Other.
6. In the right pane, select Portal Login.
7. Select OK.
8. Select Save.
9. Close the Site Manager.

Add a Portal Login Command to a Form

1. Open CSM Administrator and select Create a New Blueprint.
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2. In the Current view drop-down list, select Portal Default.
3. Select a Business Object (example: Knowledge Article) and then select Edit form.
4. In the Controls pane, select and drag a Button or Link Label onto the form.
5. Right-click the Button or Link Label and select Control properties.
6. Select the ellipsis to the right of the Action field.
7. In the left pane, select Commands.
8. In the middle pane, select System > Other.
9. In the right pane, select Portal Login.

10. Select OK and then OK again.
11. Make any additional changes to the control (Example: change displayed text from "Button" to

"Login").
12. Save the changes.
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CSM Web Applications and Accessibility
To support Users with disabilities, many Browser Client and CSM Portal features are accessible using a
keyboard and screen reader.

For best results with keyboard navigation, use the Chrome web browser.

Good to Know

• While CSM OOTB content addresses specific accessibility requirements, it is the responsibility of
each administrator and developer to ensure customized content is configured and designed to meet
accessibility requirements.

• Cherwell® strives to ensure that its applications are accessible to users with visual and auditory
impairments. There are cases, however, where accessibility may be limited. For details about CSM
accessibility, see the Accessibility Conformance Report. You must be logged in to the
Documentation Portal with customer or partner credentials to view this content.

• The CSM Web Applications have been tested with the JAWS® (Job Access With Speech) for
Windows® screen reader. Other screen readers may provide full or partial capabilities with CSM.
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CSM Web Applications Keyboard Accessibility
Keyboard commands enabled users to navigate the Browser Client and CSM Portal without using a
mouse.

General Keyboard Commands

Key Action

Tab Move forward from one link or form control to the
next.

SHIFT+Tab Move backward through one link or form control.

Enter Activate the selected link or control.

Spacebar Select a record or option.

CTRL+Spacebar Clear the current selection. For multi-selections,
clears or selects while persisting previous selections.

Page Up and Page Down Scroll the page up or down.

Arrows Scroll through links and controls on a page.

ALT+Arrow-left Move to the previous page.

ALT+Arrow-right Move to the next page.

Form Keyboard Commands
Use the following keyboard commands when focus is on a record form or an element on that form.

Key Action

Enter Selects the highlighted item.

Home Selects the first item in a drop-down.

End Selects the last item in a drop-down.

Spacebar Selects a highlighted radio button or check box.

ALT+down arrow Opens a pop-up or a drop-down.

Esc or ALT+up arrow Closes a pop-up or drop-down.

Grid Toolbar and Header Keyboard Commands
Use the following keyboard commands when focus is on the Grid column header.

Key Action

Enter Sort the column.
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Key Action

Spacebar Select and clear items.

ALT+Down arrow Opens the filter menu.

Esc Closes the filter menu.

ALT+M Toggles the Multi-column Sort option.

Grid Item List Commands
Use the following commands when focus is on the Grid item list.

Key Action

ALT+W Applies focus to the Grid item list.

Enter Expand and collapse cells.

Space Select and clear cells.

CTRL+Spacebar Select cells, but persist previously selected cells.

Page Up and Page Down Navigate through multiple Grid pages.
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Multi-Tab Browsing Support
The Browser Client and Customer Portal allow you to operate in multiple web browser tabs, which
enables you to work on multiple pages within CSM. This allows technicians, system administrators, and
customers to work more efficiently.

Multi-tab browsing allows you to:

• Log in via the first tab and then load CSM in additional tabs without needing to log in again or
consume additional licenses.

• Work with multiple CSM features at the same time. For example, a technician might log an Incident
in one tab and view their default Dashboard in another.

• Use the Culture Selector to select a language and work in the tabs independently within the same
session. If a User has multiple tabs open in different languages and the session expires or the User
manually logs out, the User is logged out of all tabs. When the User logs back in to a tab, the
language for that tab is the last language that was selected before the User logged out.

Culture support for multi-tab browsing support works slightly differently in the CSM Browser Client
than the CSM Portal:

◦ CSM Browser Client: Multi-tab browsing support allows you to open tabs in multiple languages
and work in the tabs within the same session. If you have multiple tabs open and select a new
culture, only the tab you are selecting that culture from refreshes to display the newly chosen
culture. The other tabs remain in the previous culture.

◦ CSM Portal: Multi-tab browsing support allows you to work in multiple tabs of the same culture
within the same session. If you have multiple tabs open and select a new culture, all tabs
refresh to display the newly chosen culture. You can't have multiple tabs with different cultures
open.

Multiple features use a unique tab display name, which allows Users to easily identify what they are
working in each tab. Features that support tab names include:

• Forms: Major Business Objects (Incident, Problem, etc.) use the Public ID field to populate the tab
name. The Public ID is defined in the Business Object Properties window.

• Quick Search: Quick Search results use the phrase Quick Search Results and Business Object
Quick Search Results use the phrase <Business Object> Search Results in the tab name.

• Saved Searches: Searches use the phrase <Search Name> Search Results in the tab name.
Search names are defined using the Search Manager.

• Tools: Tool drop-down items (Contact Manager, Table Management, and CMDB) use the phrase
<Tool Name> Search Results to populate the tab name.

• Reports: Reports use the phrase <Report Name> in the tab name. Report names are defined using
the Report Manager.

• Dashboards: Dashboards (Global IT, Portal pages, etc.) use the phrase <Dashboard Name> as the
tab name. Dashboard names are defined in the Dashboard Properties window.

• Calendars: Calendars use the phrase <Calendar Name> as the tab name. Calendar names are
defined in the Calendar properties window.
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• Quick View: Quick View selections use the Public ID field to populate the tab name. The Public ID
is defined in the Business Object Properties window.

• Go to Item Functionality: Go To Item selections use the Public ID field to populate the tab name.
The Public ID is defined in the Business Object Properties window.

• Startup Items: Portal Site startup items use the phrase <Startup Item Name> as the tab name. The
startup item name is defined on the Display page of the Site Editor.

• Service Catalog: The Service Catalog in the Customer Portal uses the phrase <Service Catalog>
as the tab name. The tab name is defined in the Widget Properties window of the Service Catalog
Widget.

• HTML Pages: HTML Pages use the Name field to populate the tab name. The Name is defined in
the HTML Page Options window of the HTML Editor.

• Document Repository: The Documentation Repository in the Customer Portal uses the phrase
Document Repository as the tab name.

Multi-tab browsing support is powered by a Command called New Window, which can be found in the
Command Manager.
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Open a New Tab in the Browser Client
Use multi-tab browsing support to open a new tab in the Browser Client.

1. Open a web browser.
2. Navigate to the Browser Client (http://MyServer/CherwellClient).
3. Log in using the appropriate credentials.
4. Click the User Information section of the Application Bar and select New Browser Window.

A browser window opens in a new tab and displays the default Dashboard.

Note: If you open a browser window in a new tab outside of CSM, navigate to the configured
URL. Do not copy the URL from the address bar in one tab and use it in another.

5. (Optional) Open up to four additional tabs.
When the session expires or the User manually logs out, the User is logged out of all tabs. To log
back in, the User needs to open new tabs and close the old tabs.
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Open a New Tab in the Portal
Use multi-tab browsing support to open a new tab in the Portal.

1. Open a web browser.
2. Navigate to the Portal (http://MyServer/CherwellPortal/SiteName).
3. Log in using the appropriate credentials.
4. Click the User Information section of the Application Bar and select New Browser Window.

A browser window opens in a new tab and displays the default home page.

Note: If you open a browser window in a new tab outside of CSM, navigate to the configured
URL. Do not copy the URL from the address bar in one tab and use it in another.

5. (Optional) Open up to four additional tabs.
When the session expires or the User manually logs out, the User is logged out of all tabs. To log
back in, the User needs to open new tabs and close the old tabs.
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Add a New Window Command to the Browser
Client and CSM Portal

Use the New Window command to add multi-tab browsing support to additional areas of the Browser
Client and CSM Portal.

When the command is implemented, you can navigate to CSM in additional tabs so you don't need to log
in again or consume additional licenses (the new window opens the main dashboard by default). Consider
creating a One-Step Action using the Execute a Command Action to add the functionality to even more
areas of your system.

You can add the command to multiple areas of the Browser Client, including forms and dashboards.

For example:

• Add the command (via a One-Step Action) to a Knowledge Article form using a Link Label Control
so users can easily navigate to a new window while keeping Knowledge Article information open.

• Add the command (via a One-Step Action) to the Global IT dashboard so users can easily navigate
to a record while simultaneously viewing their metrics.

You can also add the command to areas of the CSM Portal, including the menu bar and forms.

For example:

• Add the command (via a One-Step Action) to the menu bar so users can easily navigate to a new
window from anywhere in the Portal.

• Add the command (via a One-Step Action) to the read-only Knowledge Article form using a Link
Label Control so customers can easily navigate to a new window while keeping Knowledge Article
information open.

Note: For a full list of areas where you can add commands in CSM, See ../suite_features/one-
steps/add_actions_to_csm_areas.xml#D14817.
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Troubleshoot the CSM Web Applications
Administrators who have access to the server on which the web applications are installed can use
troubleshooting steps to solve issues with these applications.

If the CSM Web Applications are not working, use the following steps to troubleshoot.

1. Make sure data source setting for both and the CSM Portal and Browser Client is pointing to the
correct connection (the default is Cherwell Browser):

a. Use the Command-Line Configure utility to pass the following command to Overwatch.

/updateportalsettings /trebuchetdatasource=[Common]CherwellBrowser

b. Use the Command-Line Configure utility to pass the following command to Overwatch.

/updatebrowserclientsettings /trebuchetdatasource=[Common]CherwellB
rowser

2. Make sure the Browser Client connection is using SQL Authentication or domain account
permissions have been set up appropriately:

a. If SQL is installed on same machine as IIS, Users can give the IUSR_<machineName>
account rights to the SQL server database.

b. If SQL is not installed on the same machine as IIS, Users have to create a domain account,
give that account rights to the SQL server database and also set up the application in IIS to
use that account. In addition, Users must give that account rights to the directory (and
subdirectories) where the Browser applications are installed.

3. Make sure IIS is set up for Anonymous Access. If desired, enable Integrated Windows
Authentication:

a. Go into IIS. On the left is the Internet Information Services tree. Expand the Web Sites node
and then the Default Web Site node underneath. Find the folder for the Browser application.

◦ In IIS-7 (Windows Server 2008), click the application in the left-hand pane, then double-
click Authentication in the IIS section of the features view on the right. If Anonymous
Authentication is not enabled, select it, then click Enable in the far right Actions pane. Do
the same thing for Windows Authentication if desired. Note that, if Windows
Authentication does not appear, you might need to go the Server Manager to install the
feature.

4. Consider the Browser being used (only if you are using Windows Authentication):
◦ Firefox cannot pass Windows credentials properly unless you install their plug-in. Try Internet

Explorer and see if this works.

5. Verify that the supported version of ASP.NET is registered in the Windows Registry.
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Troubleshoot Uploading Attachments
If Users are having trouble uploading attachments, make sure that they have rights to the Attachments
directory.

1. Go into IIS and find the Attachments directory under the Self-Service virtual directory.

2. Right-click and select Properties.

3. Go to the Directory Security tab.

4. Press the Edit button in the Anonymous Access box. Ensure that User is set up.

Note: Users might also need rights to the actual directory on the hard drive.
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Troubleshoot Grids in Internet Explorer
In some older versions fo Internet Explorer, Grids sometimes do not align properly after sorting the Grid
columns. In order to correct this, Users must disable the Compatibility View setting in Internet Explorer.

To disable Compatibility View:

1. Open Internet Explorer.

2. Click Tools to open the Tools menu, and then click Compatibility View Settings.

3. If the CSM Browser Client is displayed in the list of sites to display in Compatibility mode, remove it.

4. Users can also disable Compatibility View by clicking the Compatibility View button  in the web
address bar.
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CSM Administrator
Cherwell Service Management Administrator (CSM Administrator) is CSM's administrative tool, which is
used to configure, manage, secure, integrate, and automate your CSM system.
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About CSM Administrator
Use CSM Administrator features to configure and manage your CSM system.

Administrative features include:

• Automation Processes: Pause/resume the Automation Process Service, enable/disable
Automation Processes, manage automation rules, and define Business Hours.

• Blueprints: Configure and manage system definitions (example: Business Objects, Fields, Forms,
Grids, etc.) and CSM Items (example: Dashboards, Saved Searches, etc.), and to access definition-
driven tools/functionality (example: Directory Service settings, Schemas, etc.).

• Browser and Mobile Settings: Edit Browser and Mobile options (HTML Page Manager, Twitter
Account Manager, etc.).

• Database: Import and export data, and perform system maintenance.

• E-mail and Event Monitoring: Pause/resume the E-mail and Event Monitor Service, configure
Outlook® Integration, and configure/manage e-mail accounts and settings.

• Globalization: Translate text, referred to as "strings," into one or more single-byte languages so
Users can use a single CSM installation to view the same data in multiple languages.

• mApp Solutions: Transfer bundles of CSM functionality between CSM systems.

• Performance: Run the Health Check tool to monitor and optimize system configurations that impact
performance.

• Scheduling: Pause/resume the Scheduler Service and manage scheduled items.

• Web Applications: Build/manage Customer Portals, manage Browser Client settings, and manage
browser tools.

• Security: Use Security Groups, Roles, Teams/Workgroups, and User/Customer profiles to control
people, functionality, data, environment, and sharing.

• Settings: Configure Global System settings, such as General settings (example: Search, display,
etc.), User Interface settings (example: Task Pane, toolbar, etc.), Table Management settings, etc.

• Trusted Agents: Connect to the Trusted Agents Hub and create Trusted Agents service groups.
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Log in to the CSM Desktop Client or CSM
Administrator

Log in to the CSM Desktop Client or CSM Administrator from the machine on which these Windows-
based clients are installed.

To log in to the Windows-based clients:

1. Double-click the Cherwell Service Management icon  or CSM Administrator icon  on the
desktop, or select Start>All Programs>Cherwell Service Management or Cherwell
Administrator.

Note: If the Automatically Use Connection Without Asking check box was previously
selected or if the system administrator already set up a permanent database connection, the
database connection window will not open.

2. Select the All Users tab to view database connections available to all users or the User tab to view
database connections available to only to the user logging in.

3. Select a database connection. Typically, you connect using an Application Server (3-tier

connection), identified by the Application Server icon .
4. Select the Automatically Use Connection Without Asking check box to automatically use this

database connection each time CSM is launched.
5. Provide your CSM login information:

◦ User ID: Provide your CSM login ID. This could be domain name/network user name or just a
username).

◦ Password: Provide your CSM password. Passwords are case-sensitive.
6. Select OK.

If you are assigned to more than one CSM role and have not previously selected the Automatically
Use Selected Role check box, the Choose Role window opens.

7. Select the appropriate login role for the session.
8. Select the Always Use Selected Role check box to automatically use the selected role at the next

log in.

Related concepts
Connections
About Roles
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Tour the CSM Administrator User Interface
The CSM Administrator User Interface (UI) is dynamic and changes to show helpful and appropriate
options for the administrative tasks being performed. Generally, the Main window shows the following
items:

• Menu bar: Access general administrative tasks.

• Task Pane: Access common administrative tasks, and administrative tasks organized by category.

• Main Pane: View data and to perform the majority of your administrative tasks.

When you first log in to CSM Administrator, the Main Pane displays a Getting Started page to help initially
configure the system. After initial configuration, the Main Pane automatically displays the Home page

, which lists the administrative task categories.

When working in a Blueprint, the entire UI (menu bar, Task Pane, and Main Pane) dramatically changes to
accommodate the Blueprint Editor, which is required to perform Blueprint operations.

Note: For more information about the Blueprints and the Blueprint Editor, see the Blueprint
documentation.

The following figure shows two sample Main windows:

• The Home view that appears when logging in to CSM Administrator (or click the Home button )
and includes categories of functionality.
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• The Blueprint Editor, which appears when creating a Blueprint. Notice that the Menu bar and Task
Pane change to accommodate whatever item is active in the Main Pane. A toolbar shows when the
Blueprint Editor is active.
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CSM Administrator Getting Started Page
By default, CSM Administrator opens a Getting Started page to help set up the CSM system.

Note: Also access the Getting Started page by selecting Help>Go to Getting Started Page.
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To use the Getting Started page, click the task to complete. Available options include:

• Organization Info: Edit the name, the logo, and a theme that represents the organization.

• E-mail: Select e-mail addresses to be used in Automation Processes and for various notifications.
Edit the e-mail signature in this location.

• Active Directory/LDAP: Edit the LDAP settings used to access information in a Directory Service
(a directory stored on a server).

• Escalations: Select which escalations and notification Automation Processes to enable or disable.

After you complete a task, a green check mark appears over the number of the task. When finished
setting up the CSM system and the Getting Started page is no longer needed, clear the check box at the
bottom of the window.

Note: The Menu bar is limited to File and Help and no toolbar exists. All options are accessed in
the panes.
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CSM Supporting Applications
Most supporting applications can be accessed from the Cherwell Service Management installation
directory. Exceptions include supporting web applications, which are accessed using a web browser.

The CSM suite includes the following supporting applications:

• Dashboard Viewer: The Dashboard Viewer is a stand-alone tool that displays a single CSM
dashboard or cycles through a group of dashboards (called a Slideshow) without consuming a
license.

• Report Runner: The Report Runner is a stand-alone tool that allows users to create and run reports
using CSM data without consuming a license.

• Auto-Deploy: Auto-Deploy is an installation tool that allows system administrators to automatically
distribute preconfigured client installations and connections to client machines. Auto-Deploy is
configured using the stand-alone Auto-Deploy Configuration Utility and is deployed using the Auto-
Deploy web page.

• Server Manager: The Server Manager is a stand-alone tool that allows on-premise system
administrators to efficiently monitor, manage (start, stop, or restart), and configure (database
connections, login authentication, logging, etc.) the CSM services, and restart some managed CSM
Web Applications.

• System Restore: The System Restore tool is a stand-alone database tool that allows a system
administrator to import the CSM database for the first time or reload the CSM database from an
archive file (.czar file).

• System Upgrade: The System Upgrade tool is a stand-alone database tool that allows a system
administrator to upgrade a CSM database to a new version.

• Test LDAP Tool: Test LDAP is a stand-alone diagnostics tool that allows system administrators to
test their LDAP settings.

• Outlook® Add-In: The CSM Outlook® Add-In is a CSM client that enables you to interact with CSM
Business Object records directly from within Microsoft® Outlook®.
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